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Welcome 

Introduction 
Welcome to PowerTeacher! PowerTeacher contains the PowerTeacher gradebook, a full-
featured grade-keeping application used to record, report, and monitor student 
performance. 

With PowerSchool’s powerful communication tools, everyone stays connected: Teachers can 
use their gradebook to make decisions on what information they want to share with parents, 
students stay on top of assignments, and parents are able to participate more fully in their 
student’s progress. 

Resources 
There are several resources available to assist you with PowerTeacher gradebook. They 
include: PowerTeacher Frequently Asked Questions, PowerTeacher gradebook online help, 
PowerTeacher Gradebook User Guide, PowerTeacher Gradebook Quick Reference Card, 
PowerSchool Customer Support Web site, and PowerSchool Customer Support. 

PowerTeacher Frequently Asked Questions 

To view answers about the most commonly asked PowerTeacher gradebook questions, refer 
to the PowerTeacher Frequently Asked Questions, available on the PowerSchool Customer 
Support Web site. You will need Adobe Acrobat Reader to view this document. 

PowerTeacher Gradebook Help 

To view online information on navigating and using PowerTeacher gradebook while working 
within the application, see PowerTeacher Gradebook Help. 

PowerTeacher Gradebook User Guide 

To view a print-ready version of PowerTeacher gradebook online help, refer to the 
PowerTeacher Gradebook User Guide, available on the PowerSchool Customer Support Web 
site. You will need Adobe Acrobat Reader® to view this document. 

PowerTeacher Gradebook Quick Reference Card 

To view a print-ready version of tips, tricks, and shortcuts for the most frequently used 
PowerTeacher gradebook features, refer to the PowerTeacher Gradebook Quick Reference 
Cards, available on the PowerSchool Customer Support Web site. Keep a copy of the quick 
reference card near the workstation where you use PowerTeacher gradebook. You will need 
Adobe Acrobat Reader to view this document. 
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PowerSchool Customer Support Web Site 

In addition to the above-mentioned resources, the PowerSchool Customer Support Web site 
provides a wealth of information. To access this site, go to 
https://support.powerschool.com/. 

You will need a username and password to log in. If you do not have a username and 
password, contact your PowerSchool administrator. 

Quick Start 
To get started immediately and begin taking advantage of PowerTeacher gradebook, 
perform the following tasks to set up and use the application. See the respective sections 
for detailed procedures. 

Getting Started 

Open PowerTeacher Gradebook 

PowerTeacher Gradebook Window 

Categories 

Predefined Categories 

Work with Categories 

Assignments 

Work with Assignments 

Publish Assignments 

Final Grades 

Define Final Grade Setup 

Scores and Other Information 

Work with Scores (Scoresheet) 

Work with Scores (Score Inspector) 

Work with Assignment Status (Scoresheet) 

Work with Assignment Status (Score Inspector) 

Work with Final Grade Comments (Score Inspector) 

Work with Score Comments (Score Inspector) 

Attendance 

For information on taking attendance, see the PowerTeacher User Guide. 

https://support.powerschool.com/
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Quit PowerTeacher Gradebook 

Quit PowerTeacher Gradebook 

Quick Entry Tips 
To help you to quickly accomplish tasks you perform frequently, you can use the following 
quick entry tips, which include a number of shortcut keys. Shortcut keys consist of pressing 
one or a combination of keys on the keyboard to complete a task. See the respective 
sections for detailed procedures. 

Scoresheet Keyboard Shortcuts 

Task Shortcut (Windows®) Shortcut (Mac®) 

Assignments: Assign 100% 
of points possible 

Do one of the following: 

• Enter an equal sign (=) and press ENTER to 
assign 100% of points possible for the assignment  

• Open the Score Inspector and enter an equal sign 
(=) in the Score field 

Collected: Mark or clear a 
student’s assignment as 
collected 

Do one of the following: 

• Enter Col in the score field (repeat to 
remove) 

• Enter a period (.) in the score field (repeat to 
remove) 

• Right-click in the score field and select 
Collected (repeat to remove) 

• Open the Score Inspector and select the 
Collected checkbox (deselect the checkbox 
to remove) 

• Use the Fill Scores command to apply to 
multiple students 

Comments: Add a 
comment to a student’s 
assignment score 

Do one of the following, and enter comments in the 
Comment field: 

• Press and hold CTRL+SHIFT+I 

• Right-click in the score field and select Show 
Score Inspector 

• Use the Fill Scores command to apply to 
multiple students 

Comments: Add a 
comment to a student’s 
final grade 

Do one of the following and enter comments in the 
Comment field: 

• Double-click a student’s final grade 

• Press and hold CTRL+SHIFT+I 

• Right-click a final grade and select Show 
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Task Shortcut (Windows®) Shortcut (Mac®) 

Score Inspector 

• Use the Fill Scores command to apply to 
multiple students 

Exempt: Mark a student’s 
assignment as exempt  

Do one of the following: 

• Enter Ex in the score field 

• Right-click in the score field and select 
Exempt 

• Open the Score Inspector and select the 
Exempt checkbox 

• Use the Fill Scores command to apply to 
multiple students 

Fill Scores: Assign a score, 
comment, and/or flag (late, 
collected, missing, exempt) 
to multiple students for an 
assignment 

Do one of the following: 

• Right-click in the score field and select Fill 
Scores 

• Select Fill Scores from the Tools menu  

Late: Mark or clear a 
student’s assignment as 
late  

Do one of the following: 

• Enter Lt in the score field (repeat to remove) 

• Enter an asterisk (*) in the score field 
(repeat to remove) 

• Right-click in the score field and select Late 
(repeat to remove) 

• Open the Score Inspector and select the Late 
checkbox (deselect the checkbox to remove) 

• Use the Fill Scores command to apply to 
multiple students simultaneously 

Missing/Not Handed In: 
Mark or clear a student's 
assignment as missing 

Do one of the following: 

• Enter Mi in the score field (repeat to remove) 

• Enter a forward slash (/) in the score field 
(repeat to remove) 

• Right-click in the score field and select 
Missing (repeat to remove) 

• Open the Score Inspector and select the 
Missing checkbox (deselect the checkbox to 
remove) 

• Use the Fill Scores command to apply to 
multiple students simultaneously 

Override a Final Grade Do one of the following and select the Manual Override 
checkbox: 

• Double-click a student’s final grade 
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Task Shortcut (Windows®) Shortcut (Mac®) 

• Press and hold CTRL+SHIFT+I 

• Right-click a final grade and select Show 
Score Inspector 

Zoom In Do one of the following: 

• Click a final grade field or assignment header 
and press and hold CTRL+SHIFT+= 

• Select Increase on the View menu 

Zoom Out Do one of the following: 

• Click a final grade field or assignment header 
and press and hold CTRL+SHIFT+- 

• Select Decrease on the View menu 

Score Inspector Keyboard Shortcuts 

Task Shortcut (Windows®) Shortcut (Mac®) 

Navigate to the next 
assignment 

Press and hold 
CTRL+ALT+RIGHT 
ARROW 

Press and hold 
CTRL+OPTION+RIGHT 
ARROW 

Navigate to the next 
student 

Press and hold 
CTRL+ALT+DOWN 
ARROW 

Press and hold 
CTRL+OPTION+DOWN 
ARROW 

Navigate to the previous 
assignment 

Press and hold 
CTRL+ALT+LEFT ARROW 

Press and hold 
CTRL+OPTION+LEFT 
ARROW 

Navigate to the previous 
student  

Press and hold 
CTRL+ALT+UP ARROW 

Press and hold 
CTRL+OPTION+UP 
ARROW 

Open Score Inspector
  

Do one of the following: 

• Right-click in a score field and select Score 
Inspector 

• Press and hold CTRL+SHIFT+I 

• Select Score Inspector from the Tools menu 

Main Menu Keyboard Shortcuts 

Task Shortcut (Windows®) Shortcut (Mac®) 

Copy Press and hold CTRL+C Press and hold 
COMMAND+C 
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Task Shortcut (Windows®) Shortcut (Mac®) 

Cut Press and hold CTRL+X Press and hold 
COMMAND+X 

Hide other application 
windows  

Press and hold ALT+TAB Press and hold 
OPTION+COMMAND+H 

Hide PowerTeacher 
Gradebook window 

Press and hold ALT+TAB Press and hold 
COMMAND+H 

Open Assignments window Press and hold CTRL+SHIFT+2 

Open Categories window Press and hold CTRL+SHIFT+C 

Open Class Info window Press and hold CTRL+SHIFT+5 

Open Grade Scales window Press and hold CTRL+SHIFT+G 

Open Grade Setup window Press and hold CTRL+SHIFT+4 

Open Gradebook online 
help 

Press F1 Press and hold 
COMMAND+? 

Open New Gradebook 
window 

Press and hold CTRL+N Press and hold 
COMMAND+N 

Open Reports window
  

Press and hold CTRL+SHIFT+6 

Open Score Inspector Do one of the following: 

• Right-click in a score field and select Score 
Inspector 

• Press and hold CTRL+SHIFT+I 

Open Scoresheet window Press and hold CTRL+SHIFT+1 

Open Students window
  

Press and hold CTRL+SHIFT+3 

Open the Preferences 
window  

Press and hold CTRL+, Press and hold 
COMMAND+, 

Paste Press and hold CTRL+V Press and hold 
COMMAND+V 

Quit PowerTeacher 
Gradebook 

Press and hold ALT+F4 Press and hold 
COMMAND+Q 

Recalculate Final Scores Press and hold CTRL+SHIFT+R 

Revert (discard unsaved 
changes) 

Press and hold CTRL+R Press and hold 
COMMAND+R 

Save Press and hold CTRL+S Press and hold 
COMMAND+S 
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PowerTeacher Gradebook Help 

About PowerTeacher Gradebook Help 
PowerTeacher gradebook help provides comprehensive information on navigating and using 
PowerTeacher gradebook. 

Set Browser Preferences 
Before you begin using PowerTeacher gradebook help, check your browser preferences to 
make sure your browser is set to open in a new window. 

Note: If you do not set your browser to open in a new window, the help window launches in 
the existing open window, replacing PowerTeacher. 

How to Set Browser Preferences for Firefox 

1. Open Firefox. 

2. From the menu bar, choose Firefox > Preferences (Mac) or Tools > Options 
(PC). 

3. Click Tabs. 

4. In the New pages should be opened in section, select the a new window option. 

5. Close the window. 

How to Set Browser Preferences for Internet Explorer 

Note: For PC users only. 

1. Open Internet Explorer. 

2. From the menu bar, choose Tools > Internet Options. 

3. Click General. 

4. In the Open links from other programs in section, select the A new window option. 

5. Click OK. 

How to Set Browser Preferences for Safari 

1. Open Safari. 

2. From the menu bar, choose Safari > Preferences (Mac) or Edit > Preferences 
(PC). 

3. Click General. 

4. In the Open links from applications section, select the in a new window option. 

5. Close the window. 
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Launch PowerTeacher Gradebook Help 
After you have logged in to PowerTeacher and launched the gradebook, you can launch the 
PowerTeacher gradebook help window either from the menu bar or by using the command 
keys. 

How to Launch PowerTeacher Gradebook Help 

From the gradebook menu bar, choose Help > Contents. Alternately, you can press 
COMMAND+SHIFT+? (Mac) or press F1 (Windows). 

Note: You can resize the help window and move the help window to a convenient location 
on your desktop, so you can work with PowerTeacher gradebook. The PowerTeacher 
gradebook help window remains open until you choose to close it. 

PowerTeacher Gradebook Help Window 
The PowerTeacher gradebook help window is divided into two panes, the navigation pane on 
the left and the topic pane on the right. 

Navigation Pane 

The navigation pane on the left contains the Contents, Index, and Search tabs, as well as 
navigation buttons you use to access and navigate the help topics. 

Contents Tab 

The Contents tab shows the organization of the help into folders. Each folder contains 
related topics with conceptual and procedural information. 

• Click Contents to view a complete list of the different folders. 

• Click a folder to show the topics related to that section. 

• Click the folder again to hide the topics related to that section. 

• Click a topic to view the information in the topic pane. 

• Click X to hide the navigation pane. 

Index Tab 

The Index tab provides a way to search for information interactively. The index behaves 
differently depending on the computer you are using. 

• If using Mac, topics are sorted by alphabetical listing. Click the letter that 
corresponds to the first letter of the index entry you want, and then click the topic. 
The information appears in the topic pane. 

• If using Windows, a text field appears. Click Index and enter a keyword or phrase in 
the text box. The topics containing the index term display below the text box. Click 
the appropriate topic and the information appears in the topic pane. 



 PowerTeacher Gradebook User Guide 

PowerTeacher Gradebook Help 9 

Search Tab 

The Search tab provides a way to locate occurrences of a specific word or phrase in the 
help. Click Search, enter a keyword or phrase in the text box, and then click Go. The topics 
containing the search phrase display below the text box. Select the appropriate topic and 
the information appears in the topic pane. 

Topic Pane 

The topic pane on the right displays individual help topics, such as information about 
PowerTeacher gradebook concepts or step-by-step procedures for using specific 
PowerTeacher gradebook features. 

Links 

Within help topics are links to additional information or procedures. These links display as 
underlined text. Click the underlined text to display the additional information. 
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Get Started 

About Getting Started 
To get started, you must log in to PowerTeacher and then launch the gradebook. 

Log In to PowerTeacher 
You can log in to PowerTeacher from any computer. Before you can log in to PowerTeacher, 
you will need your school's PowerTeacher URL, your username, and your password. If you 
do not have this information or have questions, contact your school’s PowerSchool 
administrator. 

Note: Do not use someone else’s password or give your password to anyone else. 

How to Log In to PowerTeacher 

1. Open your Web browser to your school's PowerTeacher URL. The Log In page 
appears. 

2. Enter your username in the first field. 

3. Enter your password in the second field. 

Note: The characters appear as asterisks (*) to ensure greater security when you 
log in. 

4. Click Enter. The PowerTeacher start page appears. 

Note: Alternately, you can press ENTER or RETURN on your keyboard. 

Launch PowerTeacher Gradebook for Mac 
After you have logged in to PowerTeacher, you can launch the gradebook from the 
PowerTeacher start page. 

Note: If you experience a loss of connection, please check your network connection or 
contact your system administrator. 

How to Launch PowerTeacher Gradebook for Mac 

1. Click Gradebook. The PowerTeacher Gradebook Launch page appears. 

2. Click Launch Gradebook. The Downloads window appears, accompanied by a 
certificate window. 

3. Click Trust. The Java Web Start and Gradebook version windows briefly appear. 
Then, PowerTeacher gradebook opens. 

Note: You can have only one active session of PowerTeacher gradebook launched at 
a time. If you attempt to launch a second session of PowerTeacher gradebook, the 
Terminate Other Sessions window appears, displaying the message, "Other active 
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sessions exist for this user account. Would you like to terminate the other sessions 
or quit this session?" Either click Terminate Other Sessions or Quit. 

Note the PowerTeacher gradebook icon that appears in the dock and the 
launchGradeBook.jnlp file that appears on your desktop. Both will be discarded 
automatically when you quit PowerTeacher gradebook. 

4. Close the Downloads window. 

Launch PowerTeacher Gradebook for Windows 
After you have logged in to PowerTeacher, you can launch the gradebook from the 
PowerTeacher start page. 

Note: If you experience a loss of connection, please check your network connection or 
contact your system administrator. 

How to Launch PowerTeacher Gradebook for Windows 

1. Click Gradebook. The PowerTeacher Gradebook Launch page appears. 

2. Click Launch Gradebook. The File Download window appears, accompanied by the 
Warning Security window. 

3. Click Run. The Java Web Start and Gradebook version windows briefly appear. Then, 
PowerTeacher gradebook opens. 

Note: You can have only one active session of PowerTeacher gradebook launched at 
a time. If you attempt to launch a second session of PowerTeacher gradebook, the 
Terminate Other Sessions window appears, displaying the message, "Other active 
sessions exist for this user account. Would you like to terminate the other sessions 
or quit this session?" Either click Terminate Other Sessions or Quit. 

4. Close the Downloads window. 

Zoom In or Out of Window 
PowerTeacher gradebook provides a zoom feature, which provides you with the flexibility to 
zoom in to see more detail of a window or zoom out to see more of the window at a reduced 
size. The zoom feature is available when using the Students, Assignment, Grades Setup, 
and Scoresheet windows. After a zoom level is selected, that zoom level becomes the 
default setting and applies to all four windows until you select a new zoom level. 

How to Use the Zoom Feature 

From the gradebook menu bar, do one of the following: 

• Choose View > Zoom > Increase to zoom in. Increments are based on the preset 
zoom levels. 

• Choose View > Zoom > Decrease to zoom out. Increments are based on the 
preset zoom levels. 

• Choose View > Zoom and a zoom level. 

Note: For additional entry options, see Quick Entry Tips. 



 PowerTeacher Gradebook User Guide 

Get Started 12 

Verify Password 
If your session has timed out, you may be asked to re-enter your password to continue 
working. 

How to Verify the Password 

1. On the Verify Password window, enter your password. 

2. Click OK. 

Note: Alternately, you can press ENTER or RETURN on your keyboard. 

View Main PowerTeacher Gradebook Window 
When you launch PowerTeacher gradebook, the main PowerTeacher Gradebook window 
appears. This window serves as the central point from which you begin your gradebook 
session. 

The PowerTeacher Gradebook window consists of the following main areas: 

• Menu Bar 

• ID Bar 

• Classes 

• Student Groups 

• Navigation Bar 

The PowerTeacher Gradebook window has four panes, Classes, Student Groups, the 
selected tab from the navigation bar, and its details. Each pane is adjustable, both 
horizontally and vertically. To adjust the width of a pane, click and hold the vertical three-
line icon and drag right or left. To adjust the height of a pane, click and hold the horizontal 
three-line icon and drag up and down. 

Menu Bar 

The menu bar appears at the top of your display and provides access to the following 
menus: 

Feature Description 

PowerTeacher 
Gradebook 

Use the pop-up menu to select one of the following commands: 

• Preferences 

• Hide PowerTeacher Gradebook 

• Quit PowerTeacher Gradebook 

File Use the pop-up menu to select one of the following commands: 

• Save 

• Revert 

Edit Use the pop-up menu to select one of the following commands: 
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Feature Description 

• Cut 

• Copy  

• Paste 

View Use the pop-up menu to select one of the following commands: 

• Scoresheet 

• Assignments 

• Students 

• Grade Setup 

• Class Info 

• Reports 

• Zoom 

Tools Use the pop-up menu to select one of the following commands: 

• Categories 

• Grade Scales 

• Score Inspector 

• Fill Scores 

• Recalculate Final Scores 

• Copy Assignment 

Window Use the pop-up menu to choose New Window to open another 
instance of gradebook so that you can access other areas of 
gradebook at one time. 

Help Use the pop-up menu to select one of the following commands: 

• Choose Contents to launch online help. For more 
information, see Launch PowerTeacher Gradebook 
Help. 

• Choose Quick Entry Tips to view keyboard shortcuts. 
For more information, see Quick Entry Tips. 

ID Bar 

The ID bar appears at the top of the PowerTeacher Gradebook window and displays your 
name and the name of your school. 

Classes 

The Classes pane appears in the upper-left corner of the PowerTeacher Gradebook window 
and includes the Term Selector and Class List. For more information, see Classes. 
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Student Groups 

The Student Groups pane appears in the lower-left corner of the PowerTeacher Gradebook 
window and displays student groups for a selected class. For more information, see 
Student Groups. 

Navigation Bar 

The navigation bar appears at the top of the PowerTeacher Gradebook window and provides 
a quick way to access the following areas: 

Feature Description 

Scoresheet Click this tab to access the Scoresheet window. 

Assignments Click this tab to access the Assignments window. 

Students Click this tab to access the Students window. 

Grade Setup Click this tab to access the Grade Setup window. 

Class Info Click this tab to access the Class Info window. 

Reports Click this tab to access the Reports window. 
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Preferences 

About Preferences 
Use Preferences to customize various aspects of PowerTeacher gradebook, including the 
Final Grade column of the Scoresheet window and the Class List in the Classes pane. 

Define Grading Preferences 
Use the Grading tab on the Preferences window to customize what final grades appear in 
the Final Grade column on the Scoresheet window. If displaying percent or points earned, 
you can indicate whether you want the final grade score rounded or truncated, as well as 
the number of decimal places you want to appear. 

How to Define Grading Preferences 

1. From the gradebook menu bar, choose Gradebook > Preferences. The 
Preferences window appears. 

2. Click the Grading tab, if not already selected. Grading preference information 
appears. 

3. Edit the information as needed. For detailed information, see the Preferences 
Window section. 

4. Click OK to save your changes. 

Note: Alternately, you can press ENTER or RETURN on your keyboard. 

Define Section Preferences 
Use the Section tab on the Preferences window to define how you want section information 
to appear in the class list in the Classed pane and in what order. 

How to Define Section Preferences 

1. From the gradebook menu bar, choose Gradebook > Preferences. The 
Preferences window appears. 

2. Click the Section tab. Section preference information appears. 

3. The Section window appears. 

4. Edit the information as needed. For detailed information, see the Preferences 
Window section. 

5. Click OK to save your changes. 

Note: Alternately, you can press ENTER or RETURN on your keyboard. 
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Classes 

About Classes 
The Classes pane appears in the upper-left corner of the PowerTeacher Gradebook window 
and includes the Term Selector and Class List. 

Select Terms 
When you first launch PowerTeacher gradebook, the current full year term appears in the 
[Term Selector] pop-up menu. The pop-up menu displays current, future, and past year 
terms, as well as any lower level terms within a term. 

How to Select a Term 

On the main PowerTeacher Gradebook window, choose a term from the [Term Selector] 
pop-up menu. Classes for the selected term appear. 

Select Classes 
When you first launch PowerTeacher gradebook, the Class List displays classes for the 
current term. The first class in your daily schedule is highlighted. 

When selecting subsequent classes, the window that appears is the last window in which 
you were working. For example, if you are working in the Assignments window and need to 
switch to another class, when you select that class, the Assignments window for the 
selected class appears. 

Note: Information that appears in the class list is defined by your section preferences. For 
more information, see Define Section Preferences. 

How to Select a Class 

On the main PowerTeacher Gradebook window, select a class from the Classes pane. The 
window in which you were last working refreshes for the selected class. 
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Class Information 

About Class Information 
The Class Information window displays basic class information about the selected class, and 
enables you to publish information about the class on the PowerSchool Parent Portal. 

View Class Information 
To view information about a particular class, select the class and click the Class Info tab. 

How to View Class Information 

1. Select a class from the Classes pane. 

2. Click the Class Info tab. The Class Information window displays basic 
information about the class. 

Add Class Descriptions 
When entering a class description, you can use plain text, HTML, or a combination of both. 
After you enter a class description, it appears on the Quick Lookup page in PowerSchool and 
on the PowerSchool Parent Portal. 

How to Add a Class Description 

1. Select a class from the Classes pane. 

2. Click the Class Info tab. The Class Information window appears. 

3. Enter the required information. For more information, see the Class Information 
Window section. 

4. Optionally, click Add Web Link to add a Web link to the class description. The Add 
Web Link window appears. 

5. Enter the required information. For detailed information, see the Add Web Link 
Window section. 

6. Click OK to close the Add Web Link window. 

7. Click Save. 

Note: The Save and Revert buttons appear shaded until information is entered. 

Edit Class Descriptions 
You can edit the class description from the Class Information window. 
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How to Edit a Class Description 

1. Select a class from the Classes pane. 

2. Click the Class Info tab. The Class Information window appears. 

3. Edit the required information. For more information, see the Class Information 
Window section. 

4. Optionally, click Add Web Link to add a Web link to the class description. The Add 
Web Link window appears. 

5. Edit the information as needed. For detailed information, see the Add Web Link 
Window section. 

6. Click OK to close the Add Web Link window. 

7. Click Save. 

Note: The Save and Revert buttons appear shaded until information is entered. 

Delete Class Descriptions 
You can delete the class description from the Class Information window. 

How to Delete a Class Description 

1. Select a class from the Classes pane. 

2. Click the Class Info tab. The Class Information window appears. 

3. Remove the text and HTML in the Description field. 

Note: There are no restrictions when deleting. 

4. Click Save. 
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Students 

About Students 
The Students window displays a list of students enrolled in a class and basic information 
about each student. 

Zoom Feature 

To increase or decrease the size of the contents within the Students window, choose View 
> Zoom. 

View Students 
To view students for a particular class, select the class and click the Students tab. 

How to View Students 

1. Select a class from the Classes pane. 

2. Click the Students tab. The Students window displays the class roster, which 
includes basic information for each student. 

Filter Students 
By default, the Students window displays students who are currently enrolled in the class. 
To view students with a different enrollment status, use the Filter By function. 

How to Filter Students 

1. Select a class from the Classes pane. 

2. Click the Students tab. The Students window appears. 

3. Do one of the following: 

• Choose ALL from the Students Filter By pop-up menu. The Students 
window refreshes and displays students who are both currently enrolled and 
those who are no longer enrolled in the class. 

• Choose Active from the Students Filter By pop-up menu. The Students 
window refreshes and displays only those students who are currently enrolled 
in the class. 

• Choose Dropped from the Students Filter By pop-up menu. The Students 
window refreshes and displays only those students who are no longer enrolled 
in the class. 
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Sort Students 
By default, the Students window displays students in ascending order by last name. Using 
the column headings, you can sort data in ascending or descending order based on the 
column heading you select. 

How to Sort Students 

1. Select a class from the Classes pane. 

2. Click the Students tab. The Students window displays students in ascending order 
by name. 

3. Click a column heading to sort the Students window by that column heading. When 
sorted in ascending order, an upward pointing arrow appears in the column heading. 
When sorted in descending order, a downward pointing arrow appears in the column 
heading. 

View Student Details 
To view student details, either double-click the student’s name or click the arrow next to the 
student’s name. 

How to View Student Details 

1. Select a class from the Classes pane. 

2. Click the Students tab. The Students window appears. 

3. Click the student's name or click the arrow next to the student's name. The Student 
Details window appears. 

View Alerts 
If an alert icon appears for a student, click the icon to view the specific text for the alert. A 
student may have one or more of the following alerts: 

• A discipline alert indicates any discipline information for the student that 
administrators want to bring to the teacher’s attention. 

• A guardian alert indicates any guardian information for the student that 
administrators want to bring to the teacher’s attention. 

• A medical alert indicates any medical information for the student that administrators 
want to bring to the teacher’s attention. 

• An other alert indicates any other information for the student that administrators 
want to bring to the teacher’s attention. 

How to View an Alert 

1. Select a class from the Classes pane. 

2. Click the Students tab. The Students window appears. 
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3. Click the student's name or click the arrow next to the student's name. The Student 
Details window appears. 

4. Click the Discipline, Guardian, Medical, or Other icon to view the alert text. The 
Alert window appears. 

5. Click OK to close the Alert window. 

Note: Alternately, you can press ENTER or RETURN on your keyboard. 



 PowerTeacher Gradebook User Guide 

Student Groups 22 

Student Groups 

About Student Groups 
Students arrive on the first day of school with different needs and levels of readiness. Using 
student groups, you can adapt instruction to the particular needs of students. Student 
groups are made up of a hierarchical structure: a set, groups within that set, and students 
within those groups. Student groups are class-specific. Therefore, you need to create 
student groups for each class in which you want to use student groups. 

Reports 

In order to generate reports for a specific set, group, individual student, selection of 
students, or any combination, you need to set up student groups. Simply create a set, a 
group, and add students to the group. Then, on a report, select the Selected Groups 
and/or Students option and then select the set, group, individual student, selection of 
students, or any combination from the Students Group pane that you want in the report. For 
example, if you need to generate a report for dropped students within a selected class, you 
can filter students by enrollment status, create a set called Reporting, create a group called 
Dropped, and then add those students to the group. 

Create Sets 
The first step to creating student groups is to create a set. Remember that the class for 
which you are creating student groups must be selected. After you have created the sets 
you want, you can create groups for those sets. 

How to Create a Set 

1. Select a class from the Classes pane. 

2. In the Student Groups pane, click the Plus (+) button and choose Add Set. 
Alternately, you can right-mouse click if you are using a two-button mouse. An 
untitled set and group appears as editable text fields. 

Note: When initially creating a set using the Plus (+) button, simply click the Plus 
(+) button to create a pre-named set and group. Any subsequent sets created will 
require you to use the Add Set button. 

3. Double-click the untitled set field and enter the name of the set. 

4. Double-click the untitled group field and enter the name of the group. 

5. Press ENTER, RETURN, or TAB to save your changes. 

Rename Sets 
You can rename a set from the Student Groups pane. 
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How to Rename a Set 

1. Select a class from the Classes pane. 

2. In the Student Groups pane, double-click the set you want to rename. The set 
appears as an editable text field. 

3. Update the field as needed. 

4. Press ENTER, RETURN, or TAB to save your changes. 

Delete Sets 
You can delete a set from the Student Groups pane. 

How to Delete a Set 

1. Select a class from the Classes pane. 

2. In the Student Groups pane, select the set you want to delete. The set appears 
highlighted in blue. 

Note: Press and hold COMMAND (Mac) or CONTROL (Windows) to select multiple 
sets. 

3. Click the Minus (-) button. If a set has groups, the Confirm window appears, 
displaying the message, "This set is not empty. Delete anyway?" If deleting more 
than one set, a Confirm window appears, displaying the message, "About to delete 
multiple sets, groups, and/or students. Continue?"  

4. Click Yes to delete the sets. The Student Groups pane appears without the deleted 
set. 

Create Groups 
After you have created a set, you can add one or more groups to that set. The class for 
which you are creating student groups must be selected. After you have created the groups 
you want, you can add students to those groups. 

How to Create a Group 

1. Select a class from the Classes pane. 

2. In the Student Groups pane, select the set or a group within the set you want to 
add a group to. Your selection appears highlighted in blue. 

Note: Click the arrow next to the set to expand a set and view the groups within the 
set. 

3. Click the Plus (+) button and choose Add Group. Alternately, you can right-mouse 
click if you are using a two-button mouse. An untitled group appears as an editable 
text field. 

Note: When creating a set, the first group in the set is automatically created. For 
more information, see Create Sets. 

4. Double-click the untitled group field and enter the name of the group. 
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5. Press ENTER, RETURN, or TAB to save your changes. 

Rename Groups 
You can rename a group from the Student Groups pane. 

How to Rename a Group 

1. Select a class from the Classes pane. 

2. In the Student Groups pane, click the expanding arrow next to the set that 
contains the group you want to rename. The groups belonging to the set appear. 

3. Double-click the group you want to rename. The group appears as an editable text 
field. 

4. Update the field as needed. 

5. Press ENTER, RETURN, or TAB to save your changes. 

Move Groups 
You can move a group from one set to another set from the Student Groups pane. 

How to Move a Group 

1. Select a class from the Classes pane. 

2. In the Student Groups pane, click the expanding arrow next to the set that 
contains the group you want to move. The groups belonging to the set appear. 

3. Select the group you want to move. The group appears highlighted in blue. 

4. Drag and drop the group into the new set. 

Delete Groups 
You can delete a group from a set from the Student Groups pane. 

How to Delete a Group 

1. Select a class from the Classes pane. 

2. In the Student Groups pane, click the expanding arrow next to the set that 
contains the group you want to delete. The groups belonging to the set appear. 

3. Select the group you want to delete. The group appears highlighted in blue. 

Note: Press and hold COMMAND (Mac) or CONTROL (Windows) to select multiple 
groups. 

4. Click the Minus (-) button. If a group has students, the Confirm window appears, 
displaying the message, "This group is not empty. Delete anyway?" If deleting more 
than one group, a Confirm window appears, displaying the message, "About to 
delete multiple sets, groups, and/or students. Continue?"  
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5. Click Yes to delete the groups. The Student Groups pane appears without the 
deleted group. 

Add Students to Groups 
After you have created a set and created one or more groups within a set, you can 
add students to a group. 

How to Add a Student to a Group 

1. Select a class from the Classes pane. 

2. In the Student Groups pane, click the expanding arrow next to the set that 
contains the group you want to add students to. 

3. Select the group. The group appears highlighted. 

4. Click the Students tab. The Students window appears. 

5. Press and hold COMMAND (Mac) or CONTROL (Windows) as you click each student 
you want to add to the group. 

6. Drag and drop the students into the group. If one or more students already belong 
to a group, the Confirm window appears, displaying the message, "Some of the 
selected students are already in this group or set. Click OK to add the remaining 
students, or click CANCEL."  

7. Click Yes to add the students. 

Move Students from Groups 
You can move one or more students from one group to another group from the Student 
Groups pane. 

How to Move a Student from One Group to Another Group 

1. Select a class from the Classes pane. 

2. In the Student Groups pane, click the expanding arrow next to the set that 
contains the group you want to move students from. The set appears highlighted. 

3. Click the expanding arrow next to the group that contains the students you want to 
move. The group appears highlighted. 

4. Select the student you want to move. The student appears highlighted in blue. 

Note: Press and hold COMMAND (Mac) or CONTROL (Windows) to select multiple 
students. 

5. Drag and drop the student to the new group. 

Remove Students from Groups 
You can remove a student from a group from the Student Groups pane. 
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How to Remove a Student from a Group 

1. Select a class from the Classes pane. 

2. In the Student Groups pane, click the expanding arrow next to the set that 
contains the group you want to remove students from. The set appears highlighted. 

3. Click the expanding arrow next to the group that contains the students you want to 
remove. The group appears highlighted. 

4. Select the student you want to remove. The student appears highlighted in blue. 

Note: Press and hold COMMAND (Mac) or CONTROL (Windows) to select multiple 
students. 

5. Click the Minus (-) button. The Student Groups pane appears without the removed 
student. If removing more than one student, a Confirm window appears, displaying 
the message, "About to delete multiple sets, groups, and/or students. Continue?" 

6. Click Yes to remove the students. 
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Assignment Categories 

About Categories 
Before you can create assignments, you must set up categories. Categories are groups of 
the same types of assignments. Categories are not class-specific, eliminating the need to 
create the same categories multiple times for each class. By default, PowerTeacher 
gradebook includes four pre-defined categories: Homework, Project, Quiz, and Test. 

Include in Final Grade 

When setting up categories, you can use the Include in Final Grade checkbox to indicate 
whether assignments within a category should be included in calculating final grades. The 
value set for a category is used as a default for all assignments within that category, but 
may be overridden on an assignment-by-assignment basis. 

View Categories 
To view categories, you do not need to select a class. Simply navigate to the Categories 
window using the gradebook menu bar. 

How to View Categories 

1. From the gradebook menu bar, choose Tools > Categories. The Categories 
window appears. A list of categories appears on the left side of the window. If 
necessary, use the scroll bar to view the entire list of categories. 

2. Select a category. Detailed information for the category appears on the right of the 
window. 

Add Categories 
Use the Categories window to create assignment categories. 

How to Add a Category 

1. From the gradebook menu bar, choose Tools > Categories. The Categories 
window appears. 

2. Click the Plus (+) button. The new category appears on the left side of the window. 

3. Enter the required information. For detailed information, see the Categories 
Window section. 

4. Click Close to save your changes. The Categories window closes. 

Edit Categories 
You can edit a category from the Categories window. 
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How to Edit a Category 

1. From the gradebook menu bar, choose Tools > Categories. The Categories 
window appears. 

2. Select the category you want to edit. The category details appear. 

3. Edit the information as needed. For detailed information, see the Categories 
Window section. 

4. Click Close to save your changes. 

Delete Categories 
You can delete a category from the Categories window. 

How to Delete a Category 

1. From the gradebook menu bar, choose Tools > Categories. The Categories 
window appears. 

2. Select the category you want to delete. 

3. Click the Minus (-) button. The Categories window appears without the deleted 
category. 

If category has assignments or is used in weighting, the Alert window appears, 
displaying the message, "Unable to delete category because it has associated 
assignments."  

4. Click OK to close the window. 

5. Click Close to save your changes. 
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Assignments 

About Assignments 
You can create one assignment at a time as you progress through the term, or you can set 
up assignments for the entire term before the term starts. Having all assignments for the 
term before the term starts does not change how grades appear. The Final Grade that 
appears on the Scoresheet reflects an average grade for only the assignment scores that 
have been entered. 

Before setting up an assignment, consider how you will score the assignment: 

• Do you want to record the score as points, a percentage, or letter grade?  

• How many points is the assignment worth?  

• How do you want to weight the assignment?  

• Do you want to include the assignment in final grade calculation? 

Include in Final Grade 

When setting up assignments, you can use the Include in Final Grade checkbox to 
indicate whether an assignment should be included in calculating final grades. The value set 
for a category is used as a default for all assignments within that category, but may be 
overridden on an assignment-by-assignment basis. 

If an assignment is included in calculating final grades and impacts the final grade, it must 
be published in order for parents and students to view it. The Publish Assignment pop-up 
menu cannot be set to Never. For more information, see Publish Assignments. 

Weighting 

Assignment setup may involve weighting; however, weighting is not required. Weighting 
gives particular assignments, whether points, percentage, or letter grades, more value than 
others when determining final grades. The weight value is used to multiply the points 
earned and the points possible. 

Zoom Feature 

To increase or decrease the size of the contents within the Assignments window, choose 
View > Zoom. 

View Assignments 
To view assignments for a particular class, select the class and click the Assignments tab. 

How to View Assignments 

1. Select a class from the Classes pane. 
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2. Click the Assignments tab. The Assignment window displays class assignments 
and basic information about each assignment. 

Filter Assignments 
By default, the Assignments window displays assignments for all categories for the entire 
length of the class. To view assignments with a due date that falls within a specific reporting 
term, week, or month, or view assignments that belong to a specific category, use the 
Filter By function. 

How to Filter Assignments 

1. Select a class from the Classes pane. 

2. Click the Assignments tab. The Assignments window appears. 

3. Do one or both of the following: 

• Choose a reporting term, week, or month from the Filter By Reporting 
Term pop-up menu. The Assignments window refreshes and displays only 
those assignments with a due date that falls within that selected reporting 
term, week, or month. 

Note: The selected reporting term becomes the new default setting. 

• Choose a category from the Filter By Category pop-up menu. The 
Assignments window refreshes and displays only those assignments that 
belong to the selected category. 

Sort Assignments 
By default, the Assignments window displays assignments in ascending order by name. 
Using the column headings, you can sort data in ascending or descending order based on 
the column heading you select. 

How to Sort Assignments 

1. Select a class from the Classes pane. 

2. Click the Assignments tab. The Assignments window displays the assignments in 
ascending order by name. 

3. Click a column heading to sort the Assignments window by that column heading. 
When sorted in ascending order, an upward pointing arrow appears in the column 
heading. When sorted in descending order, a downward pointing arrow appears in 
the column heading. 

Add Assignments 
You can add assignments from the Assignments window or the Scoresheet window using 
the Plus (+) button. Alternately, you can right-mouse click if you are using a two-button 
mouse. 
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How to Add an Assignment 

1. Select a class from the Classes pane. 

2. Click the Assignments tab. The Assignments window appears. 

3. Click the Plus (+) button. The New Assignment window appears. 

4. Enter the required information. For detailed information, see the Assignments 
Window section. 

5. To make the assignment visible to parents, see Show Assignments. 

6. Click Save. 

Edit Assignments 
You can edit an assignment from the Assignments window or the Scoresheet window. 

How to Edit an Assignment 

1. Select a class from the Classes pane. 

2. Click the Assignments tab. The Assignments window appears. 

3. Double-click the assignment you want to edit. The assignment details appear. 

4. Edit the information as needed. For detailed information, see the Assignments 
Window section. 

5. To make the assignment visible to parents, see Show Assignments. 

6. Click Save. 

Note: If Points Possible is modified for an assignment where student point-based 
scores exists, the Points Possible Has Changed window appears. You can either click 
Keep Scores to keep the scores as-is or click Adjust Scores to adjust them based 
on the new points possible. 

Copy Assignments 
You can use the Copy Assignment function to copy an assignment within a class or from one 
class to other classes. You can copy assignments from the Assignments window or the 
Scoresheet window using the gradebook menu bar. Alternately, you can right-mouse click 
if you are using a two-button mouse. 

When copying an assignment, the assignment details and publish settings are copied to the 
new assignment, with the exception of the assignment score. If an assignment with same 
name or abbreviation already exists in the class you are copying the assignment to, such as 
“FirstHW”, the suffix “_<next larger number>” is appended to the assignment name or 
abbreviation, such as “FirstHW_1." 

Note: When copying an assignment, the due date of the new assignment populates based 
on the due date you select. If the due date you select is not a valid date within the target 
section, then the due date of the new assignment is calculated based on the following: 

• If the due date is before the section start date, then the field defaults to the section 
start date. 
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• If the due date is after the section end date, then the field defaults to the section 
end date. 

How to Copy an Assignment 

1. Select a class from the Classes pane. 

Note: Section numbers do not appear on the Class List. To view this information 
while you are copying assignments, launch an additional window from the gradebook 
menu bar by choosing Window > New. In the new window, click the Class Info 
tab. 

2. Click the Assignments tab. The Assignments window appears. 

3. Select an assignment. 

4. Either choose Tools > Copy Assignment from the gradebook menu bar or right-
mouse click and select Copy Assignment. The Copy Assignment window 
appears. 

5. Edit the information as needed. For detailed information, see the Copy Assignment 
Window section. 

6. Click OK. The assignment is copied to the selected classes. If the assignment is 
copied to same class, the new assignment appears in the Assignments or Scoresheet 
window. 

Note: If you opened a second window to view section numbers, close it. 

Delete Assignments 
You can delete an assignment from the Assignments window or the Scoresheet window 
using the Minus (-) button. Alternately, you can right-mouse click if you are using a two-
button mouse. 

How to Delete an Assignment 

1. Select a class from the Classes pane. 

2. Click the Assignments tab. The Assignments window appears. 

3. Select the assignment you want to delete. The assignment details appear. 

4. Click the Minus (-) button. The Delete Assignment window appears. 

If an assignment does not have scores, the Delete Assignment window states, "Are 
you sure you want to delete assignment [name]?"  

If an assignment has scores, the Delete Assignment window states, "This assignment 
has scores. Are you sure you want to delete assignment [name] and all associated 
scores?"  

5. Click Yes. The assignment no longer appears on the Assignment window. 

Publish Assignments 
After you enter an assignment, the assignment appears on the Quick Lookup page in 
PowerSchool. In order for parents and students to view this information on the PowerSchool 
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Parent Portal, you need to publish it either from the Assignments window or the 
Scoresheet window. 

How to Publish an Assignment 

1. Select a class from the Classes pane. 

2. Click the Assignments tab. The Assignments window appears. 

3. Select the assignment you want to publish. The assignment details appear. 

4. Click Publish. 

5. From the Publish Assignment pop-up menu, choose when to publish the 
assignment: Immediately, On Specific Date, Days Before Due, or On Due 
Date. 

6. If you chose On Specific Date, enter the date the assignment should appear in the 
Date On field using the format mm/dd/yyyy, or click the Calendar icon to select a 
date. 

7. If you chose Days Before Due, enter the number of days the assignment should 
appear prior to the date that it is due in the Days Before Due field. 

8. Click Save. 

Hide Assignments 
After you enter an assignment, the assignment appears on the Quick Lookup page in 
PowerSchool. In order for parents and students to view this information on the PowerSchool 
Parent Portal, you will need to publish it. If you do not want to make an assignment 
available on the PowerSchool Parent Portal, elect to never publish the assignment. This be 
done from the Assignments window or the Scoresheet window. 

Note: If an assignment is included in calculating final grades and impacts the final grade, it 
must be published in order for parents and students to view. The Publish Assignment 
pop-up menu cannot be set to Never. For more information, see Publish Assignments. 

How to Hide an Assignment 

1. Select a class from the Classes pane. 

2. Click the Assignments tab. The Assignments window appears. 

3. Select the assignment you do not want published. The assignment details appear. 

4. Click Publish. 

5. Choose Never from the Publish Assignment pop-up menu. 

6. Click Save. 

Publish Assignment Scores 
When publishing an assignment, you also have the option to publish the assignment 
score. If you elect to publish assignment scores, parents and students can view this 
information on the PowerSchool Parent Portal. This can be done from the Assignments 
window or the Scoresheet window. 
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How to Publish Assignment Scores 

1. Select a class from the Classes pane. 

2. Click the Assignments tab. The Assignments window appears. 

3. Select an assignment. The assignment details appear. 

4. Click Publish. 

5. Select the Publish Scores checkbox. 

Note: If the Publish Assignment pop-up menu is set to Never, do not select the 
checkbox. 

6. Click Save. 

Hide Assignment Scores 
When publishing an assignment, you also have the option to not publish the assignment 
score. If you elect not to publish assignment scores, parents and students cannot view this 
information on the PowerSchool Parent Portal. This can be done from the Assignments 
window or the Scoresheet window. 

How to Hide Assignment Scores 

1. Select a class from the Classes pane. 

2. Click the Assignments tab. The Assignments window appears. 

3. Select an assignment. The assignment details appear. 

4. Click Publish. 

5. Deselect the Publish Scores checkbox. 

6. Click Save. 
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Grade Scales 

About Grade Scales 
PowerTeacher gradebook uses a default grade scale that is set up and managed by your 
school's district administrators. You can view detailed information about the default grade 
scale or you can view the grade scale for a specific class. 

View All Grade Scales 
Use the following procedure to view all grade scales associated to your school/district. 

How to View Grade Scales 

1. From the gradebook menu bar, choose Tools > Grade Scales. The Grade Scales 
window displays basic information for each grade scale. 

2. Click Close when done viewing. 

View Class Grade Scales 
Use the following procedure to view grade scales associated to a specific class. 

How to View Grade Scales Associated to a Specific Class 

1. Select a class from the Classes pane. 

2. Click the Class Info tab. The Class Information window appears. The name of 
the grade scale associated to this class appears in the Grade Scale field. 
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Final Grades 

About Final Grades 
Using a combination of options, you can control how Final Grades are calculated in your 
classes. Final Grade Preferences apply to all of your classes while Final Grade Setup 
applies to a specific class and must be set up within each class. 

Final Grade Setup 

Use final grade setup to specify how you want final grades to be calculated for students in 
your classes. 

Final Grades and Categories 

When setting up categories, you can use the Include in Final Grade checkbox to indicate 
whether assignments within a category should be included in calculating final grades. 

Final Grades and Assignments 

When setting up assignments, you can use the Include in Final Grade checkbox to 
indicate whether assignments should be included in calculating final grades. 

Note: The value set within an assignment overrides the value for the category the 
assignment belongs to. 

Weighting 

Final grade setup may involve weighting; however, weighting is not required. Weighting 
gives particular assignments, categories, or terms more value than others when 
determining final grades. The weight value is used to multiply the points earned and the 
points possible. 

Zoom Feature 

To increase or decrease the size of the contents within the Grades Setup window, choose 
View > Zoom. 

View Reporting Terms 
To view reporting terms for your school, select the class and click the Grades Setup tab. 

How to View Reporting Terms 

1. Select a class from the Classes pane. 
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2. Click the Grades Setup tab. The Grades Setup window displays reporting term 
information for the section you are in. 

Calculate Final Grades by Total Points 
The total points method calculates final grades based on how many points a student has 
accumulated over the term divided by total points possible. 

Note: You can calculate final grades by total points for all reporting terms within the 
reporting term hierarchy. 

How to Calculate Final Grades by Total Points 

1. Select a class from the Classes pane. 

2. Click the Grades Setup tab. The Grades Setup window appears. 

3. Click the name of the reporting term you want to set up final grade calculation for. 

Note: Calculate Final Grade Using options are based on the selected reporting 
term. 

4. Select the Total Points option for Calculate Final Grade Using. 

5. Enter the number of low scores you want to drop from the final grade calculation in 
the Number of low scores to discard field. 

6. Click Save. 

Calculate Final Grades by Term Weight 
The term weight method calculates final grades based on the total points times the value 
(or weight) of each term. 

Note: You can calculate final grades by term weights for reporting terms within the 
reporting term hierarchy that have shorter reporting terms within them. 

How to Calculate Final Grades by Term Weight 

1. Select a class from the Classes pane. 

2. Click the Grades Setup tab. The Grades Setup window appears. 

3. Click the name of the reporting term you want to set up final grade calculation for. 

Note: Calculate Final Grade Using options are based on the selected reporting 
term. 

4. Select the Term Weights option for Calculate Final Grade Using. Term weights 
for the selected reporting term appear. 

5. Double-click the term’s Weight field. The field appears as an editable text field. 

6. Enter the weight. 

Note: Up to two decimals may be entered. 

7. Click Save. 



 PowerTeacher Gradebook User Guide 

Final Grades 38 

Calculate Final Grades by Category Weight 
The category weight method calculates final grades based on total points times the value 
(or weight) of each category or assignment. 

Note: You can calculate final grades by category weight for all reporting terms within the 
reporting term hierarchy. 

How to Calculate Final Grades by Category Weight 

1. Select a class from the Classes pane. 

2. Click the Grades Setup tab. The Grades Setup window appears. 

3. Click the name of the reporting term you want to set up final grade calculation for. 

Note: Calculate Final Grade Using options are based on the selected reporting 
term. 

4. Select the Category Weights option for Calculate Final Grade Using. 

To add a category: 

1. Click Add Category. The Select Category window appears. 

2. Select the checkbox next to each category you want to add. 

3. Click OK. The category appears on the Grades Setup window. 

4. Double-click the category’s Weight field. The field appears as an editable text field. 

5. Enter the weight. 

6. Double-click the category’s Drop Low field. The field appears as an editable text 
field. 

7. Enter the number of low scores you want to drop from the final grade calculation. 

8. Click Save. 

9. Repeat for each additional category. 

To remove a category: 

1. Select the category you want to delete. The category appears highlighted. 

2. Click Remove. 

3. Click Save. 

To add an assignment: 

Note: The option to add an assignment is only available for the lower level terms within a 
term. 

1. Click Add Assignment. The Select Assignment window appears. 

2. Select the checkbox of the assignment you want to add. 

3. Click OK. The assignment appears on the Grades Setup window. 

4. Double-click the assignment’s Weight field. The field appears as an editable text 
field. 

5. Enter the weight. 

6. Click Save. 
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7. Repeat for each additional assignment. 

To remove an assignment: 

1. Select the assignment you want to delete. The assignment appears highlighted. 

2. Click Remove. 

3. Click Save. 

Manually Override Final Grades 
After you enter final grades, you may need to override a calculated final grade for a 
student. When overriding a calculated grade, you can set a unique value for both percent 
and letter grade. 

How to Manually Override a Final Grade 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Choose a reporting term, week, or month from the Filter By Reporting Term pop-
up menu. The Scoresheet window refreshes and displays only those assignments and 
scores with a due date that falls within that selected reporting term, week, or month. 

4. Open the Score Inspector. The Score Inspector window appears. 

Note: For additional entry options, see Quick Entry Tips. 

5. Select the final grade of the student you want to update. The final grade field 
appears highlighted. The assignment details appear in the Score Inspector window. 

6. Select the Manual Override checkbox. 

7. Enter the new percent in the Percent field, if applicable. 

8. Enter the new letter grade in the Grade field, if applicable. 

9. Enter final grade text in the Comment field, if applicable. 

Note: It is not necessary to select the Manual Override checkbox in order to add, 
edit, or delete a final grade comment. 

10. Use the Previous and Next arrows to repeat for each student, if applicable. 

11. Click Save. The final grade appears within the selected student final grade field. 

Note: The final grade appears bolded, italicized, and with a red circular “!”. If a 
comment was entered, a blue circular “C” also appears. 

Recalculate Final Scores  
Recalculate Final Scores is a special function that is used as a final option when there is a 
question as to the accuracy of a final grade. This function is most commonly used when 
administrators change certain data that impacts final grade calculations. For example, any 
changes made to a grade scale for a section, such as the actual assigned grade scale or a 
modification to one or more grades within a grade scale will not be reflected in 
PowerTeacher gradebook until you recalculate final scores. 
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When recalculating final scores, final scores are recalculated for all students, both active and 
dropped. Recalculating final scores for dropped students is critical when a student has 
changed enrollment, but you have not yet received or scored all assignments. After you 
have, you can recalculate final scores and then distribute the updated information to the 
student's new teacher via email or another method. 

How to Recalculate Final Scores 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. From the gradebook menu bar, choose Tools > Recalculate Final Scores. The 
Scoresheet window refreshes, showing the recalculated final scores. 
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Scoresheets 

About Scoresheets 
The Scoresheet window is where you will probably spend most of your time. Using the 
Scoresheet window, you can create and score assignments and view final grades for 
students in your classes. 

Zoom Feature 

To increase or decrease the size of the contents within the Scoresheet window, choose 
View > Zoom. 

View Scoresheets 
To view assignments and scores for a particular class, select the class and click the 
Scoresheet tab. 

Note: Past assignments are separated from future assignments by a divider and appear 
slightly shaded. 

How to View a Scoresheet 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window displays basic score 
information. 

Filter Scoresheets 
By default, the Scoresheet window displays assignments and scores for all categories for 
students enrolled in the full length of the class. To view assignments and scores with a due 
date that falls within a specific reporting term, week, or month; view assignments that 
belong to a specific category; or view assignments and scores for students with a different 
enrollments status, use the Filter By function. 

How to Filter a Scoresheet 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Do one or more of the following: 

• Choose a reporting term, week, or month from the Filter By Reporting 
Term pop-up menu. The Scoresheet window refreshes and displays only 
those assignments and scores with a due date that falls within that selected 
reporting term, week, or month. 

Note: The selected reporting term becomes the new default setting. 
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• Choose a category from the Filter By Category pop-up menu. The 
Scoresheet window refreshes and only displays assignments and scores for 
the selected category. 

• Choose an enrollment status from the Filter By Students pop-up menu. The 
Scoresheet window refreshes and only displays assignments and scores for 
students with the selected enrollment status. For more information, see Filter 
Class Roster. 

View Scoresheet Statistics 
The Summary section of the Scoresheet provides statistical information for assignments and 
final grades. 

The mean is the mathematical average of the scores you entered. The median represents 
the middle of all values: one-half of the scores will be above this number and one-half will 
be below it. The mode indicates the most common value. 

All of these values are indicators of how well students do on assignments. If any one of 
them is unexpectedly low, it may be that students need additional practice on the skills and 
concepts being assessed, or the assessment needs to be revised. 

How to View Scoresheet Statistics 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Click Summary if not already displayed. The mean, median, and mode for each 
assignment and final grade appears. 

4. Select an assignment. The points earned, percentage, and grade to date appear in 
the lower-left corner of the Scoresheet. 

Mark Assignments Collected Using Scoresheet 
To indicate that an assignment for a student has been collected, mark the assignment as 
Collected from the Scoresheet window or the Score Inspector. An assignment can be 
marked as collected with or without entering a score. If no score is entered, a green 
checkmark appears within the selected student assignment score field. If a score is entered, 
the checkmark is replaced with the score. 

How to Mark an Assignment as Collected 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Click in the assignment column of the student whose assignment has been collected. 

4. Enter Col in the score field. 

Note: For additional entry options, see Quick Entry Tips. 

5. Click Save. The score appears on the Scoresheet window. 

Note: The Save and Revert buttons appear shaded until information is entered. 



 PowerTeacher Gradebook User Guide 

Scoresheets 43 

Mark Assignments Late Using Scoresheet 
To indicate that an assignment for a student is late, mark the assignment as Late from the 
Scoresheet window or the Score Inspector. An assignment can be marked as late with or 
without entering a score. When marked as late, a red circular “L” appears within the 
selected student assignment score field. 

How to Mark an Assignment as Late 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Click in the assignment column of the student whose assignment is late. 

4. Enter Lt in the score field. 

Note: For additional entry options, see Quick Entry Tips. 

5. Click Save. The score appears on the Scoresheet window. 

Note: The Save and Revert buttons appear shaded until information is entered. 

Mark Assignments Exempt Using Scoresheet 
To indicate that an assignment for a student is exempt, mark the assignment as Exempt 
from the Scoresheet window or the Score Inspector. An assignment can be marked as 
exempt with or without entering a score. If no score is entered, an italicized “Ex” appears 
within the selected student assignment score field. If a score is entered, the score appears 
italicized and shaded. 

How to Mark an Assignment as Exempt 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Click in the assignment column of the student who you want to exempt from the 
assignment. 

4. Enter Ex in the score field. 

Note: For additional entry options, see Quick Entry Tips. 

5. Click Save. The score appears on the Scoresheet window. 

Note: The Save and Revert buttons appear shaded until information is entered. 

Mark Assignments Missing Using Scoresheet 
To indicate that an assignment for a student is missing, mark the assignment as Missing 
from the Scoresheet window or the Score Inspector. If marked as missing, an orange 
circular “M” appears within the selected student assignment field. If the assignment is 
marked as Collected, the orange "M" is replaced with a green checkmark. If a score is 
entered, the orange "M" is replaced with is replaced with the score. 
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How to Mark an Assignment as Missing 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Click in the assignment column of the student whose assignment is missing. 

4. Enter Mi in the score field. 

Note: For additional entry options, see Quick Entry Tips. 

5. Click Save. The score appears on the Scoresheet window. 

Note: The Save and Revert buttons appear shaded until information is entered. 

Enter Scores Using Scoresheet 
You can enter scores from the Scoresheet window or the Score Inspector. 

Shortcut Key 

When entering scores, you can use the equal sign (=) to populate the score field with the 
maximum score possible for an assignment based on the scoring type of the assignment. 
For percentage, 100% is entered. For points, the maximum possible points for the 
assignment are entered. For a letter grade, the highest possible grade in the grade scale 
associated with the section is entered. 

How to Enter a Score 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Click the assignment column of the student you want to enter a score for. The score 
field appears as an editable text field. 

4. Enter the score in the score field. 

Note: For additional entry options, see Quick Entry Tips. 

5. Press ENTER or RETURN. The score appears on the Scoresheet and the cursor 
advances to the next assignment field. 

6. Click Save. The score appears on the Scoresheet window. 

Note: The Save and Revert buttons appear shaded until information is entered. 

Edit Scores Using Scoresheet 
You can edit a score from the Scoresheet window or the Score Inspector. 

How to Edit a Score 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Click the score you want to edit. The score field appears as an editable text field. 
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4. Enter the new score in the score field. 

Note: For additional entry options, see Quick Entry Tips. 

5. Press ENTER or RETURN. The new score appears on the Scoresheet and the cursor 
advances to the next assignment field. 

6. Click Save. The new score appears on the Scoresheet window. 

Note: The Save and Revert buttons appear shaded until information is entered. 

Delete Scores Using Scoresheet 
You can delete a score from the Scoresheet window or the Score Inspector. 

How to Delete a Score 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Click the score you want to delete. The score field appears as an editable text field. 

4. Highlight the score and press DELETE. 

5. Press ENTER or RETURN. The score no longer appears on the Scoresheet and the 
cursor advances to the next assignment field. 

Fill Scores 
Use the Fill Scores command to quickly and easily enter the same score for all students or 
for only those with unrecorded scores. For example, if all but two students in a class receive 
the same assignment score, use the Fill Scores function to enter that score for the class 
with the exception of the scores already entered for the two students. 

You can fill scores from the gradebook menu bar. Alternately, you can right-mouse click if 
you are using a two-button mouse. 

How to Fill Scores 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Select the assignment column for which you want to fill scores. 

4. From the gradebook menu bar, choose Tools > Fill Scores. The Fill Scores 
window appears. 

5. Indicate whether you want to only fill empty scores or replace all scores by selecting 
one of the following options: 

• Fill empty scores for the selected assignment 

• Replace all scores for the selected assignment 

6. To indicate the assignment status, select one of the following: 

• Collected 
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• Late 

• Exempt Score 

7. Enter the score in the Score field. 

8. Manually enter score comments in the Comment field or click Comment Bank to 
select one or more predefined comments. 

Note: If using the Comment Bank, you can press and hold COMMAND (Mac) or 
CONTROL (Windows) to select multiple comments. When you have finished making 
your selections, click Insert Selected Comments and then click OK. 

9. Click OK. 
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Score Inspector 

About Score Inspector 
The Score Inspector provides an alternative way of entering scores and other information. 
After you open the Score Inspector window, it floats above the Scoresheet window. You may 
want to move it to a convenient location on your desktop, so you can work with the 
Scoresheet. The Score Inspector remains open until you close it. 

Zoom Feature 

To increase or decrease the size of the contents within the Scoresheet window, choose 
View > Zoom. 

Open Score Inspector 
You can open the Score Inspector from the gradebook menu bar or the Scoresheet window. 

Note: To help you to quickly accomplish tasks you perform frequently, see Quick Entry 
Tips. 

How to Open Score Inspector 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Do one of the following: 

• From the gradebook menu bar, choose Tools > Score Inspector. The Score 
Inspector window appears. 

• From any assignment field (or Final Grade field) within the Scoresheet, press 
COMMAND+click (Mac) or right-click (Windows) and select Score 
Inspector. The Score Inspector window appears. 

View Assignment Score Details 
You can view assignment details from the Score Inspector window. 

How to View Assignment Score Details 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Click in the assignment column of the student you want to view assignment score 
information for. The assignment details appear in the Score Inspector window. 
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View Final Grade Details 
You can view final grade details from the Score Inspector window. 

How to View Final Grade Details 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Click in the final grade column of the student you want to view final grade 
information for. The final grade details appear in the Score Inspector window. 

Mark Assignments Collected Using Score Inspector 
To indicate that an assignment for a student has been collected, mark the assignment as 
Collected using the Score Inspector or the Scoresheet window. An assignment can be 
marked as collected with or without entering a score. If no score is entered, a green 
checkmark appears within the selected student assignment score field. If a score is entered, 
the checkmark is replaced with the score. 

How to Mark an Assignment as Collected 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Click in the assignment column of the student whose assignment has been collected. 
The assignment details appear in the Score Inspector window. 

5. Select the Collected checkbox. 

Note: For additional entry options, see Quick Entry Tips. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's assignment or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. 

Mark Assignments Late Using Score Inspector 
To indicate that an assignment for a student is late, mark the assignment as Late using the 
Score Inspector or the Scoresheet window. An assignment can be marked as late with or 
without entering a score. If marked as late, a red circular “L” appears within the selected 
student assignment field. 

How to Mark an Assignment as Late 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 
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3. Open the Score Inspector. The Score Inspector window appears. 

4. Click in the assignment column of the student whose assignment is late. The 
assignment details appear in the Score Inspector window. 

5. Select the Late checkbox. 

Note: For additional entry options, see Quick Entry Tips. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's assignment or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. 

Mark Assignments Exempt Using Score Inspector 
To indicate that an assignment for a student is exempt, mark the assignment as Exempt 
using the Score Inspector or the Scoresheet window. An assignment can be marked as 
exempt with or without entering a score. If no score is entered, an italicized “Ex” appears 
within the selected student assignment score field. If a score is entered, the score appears 
italicized and shaded. 

How to Mark an Assignment as Exempt 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Click in the assignment column of the student who you want to exempt from the 
assignment. The assignment details appear in the Score Inspector window. 

5. Select the Exempt checkbox. 

Note: For additional entry options, see Quick Entry Tips. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's assignment or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. 

Mark Assignments Missing Using Score Inspector 
To indicate that an assignment for a student is missing, mark the assignment as Missing 
using the Score Inspector or the Scoresheet window. If marked as missing, an orange 
“M” appears within the selected student assignment field. If the assignment is marked as 
Collected, the orange "M" is replaced with a green checkmark. If a score is entered, the 
orange "M" is replaced with is replaced with the score. 

How to Mark an Assignment as Missing 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 
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3. Open the Score Inspector. The Score Inspector window appears. 

4. Click in the assignment column of the student whose assignment is late. The 
assignment details appear in the Score Inspector window. 

5. Select the Missing checkbox. 

Note: For additional entry options, see Quick Entry Tips. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's assignment or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. 

Enter Scores Using Score Inspector 
You can enter scores using the Score Inspector or the Scoresheet window. 

How to Enter a Score 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Select the assignment of the student you want to update. The assignment details 
appear in the Score Inspector window. 

5. Enter the score in the Score field. 

Note: For additional entry options, see Quick Entry Tips. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's assignment or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. The score appears on the Scoresheet window. 

Edit Scores Using Score Inspector 
You can edit a score using the Score Inspector or the Scoresheet window. 

How to Edit a Score 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Select the assignment of the student you want to update. The assignment details 
appear in the Score Inspector window. 

5. Enter the new score in the Score field. 

Note: For additional entry options, see Quick Entry Tips. 
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6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's assignment or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. The new score appears on the Scoresheet 
window. 

Delete Scores Using Score Inspector 
You can delete a score using the Score Inspector or the Scoresheet window. 

How to Delete a Score 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Select the assignment of the student you want to update. The assignment details 
appear in the Score Inspector window. 

5. Highlight the score and press DELETE. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's assignment or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. The score no longer appears on the 
Scoresheet. 

Add Assignment Score Comments 
When entering an assignment score comment, you can use plain text, HTML, or a 
combination of both. After you enter the assignment score comment, it appears on the 
Quick Lookup page in PowerSchool. In order for parents and students to view this 
information on the PowerSchool Parent Portal, you need to publish it. 

How to Add an Assignment Score Comment 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Select the assignment of the student you want to update. The assignment details 
appear in the Score Inspector window. 

5. Manually enter assignment score comments in the Comment field or click Comment 
Bank to select one or more predefined comments. 

Note: For additional entry options, see Quick Entry Tips. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 
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Note: Click Clear to discard changes made to the selected student's assignment or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. A blue circular “C” appears within the selected 
student assignment score field. 

Edit Assignment Score Comments 
You can edit an assignment score comment using the Score Inspector. 

How to Edit a Score Comment 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Select the assignment of the student you want to update. The assignment details 
appear in the Score Inspector window. 

5. Manually enter assignment score comments in the Comment field or click Comment 
Bank to select one or more predefined comments. 

Note: For additional entry options, see Quick Entry Tips. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's assignment or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. A blue circular “C” appears within the selected 
student assignment score field. 

Delete Assignment Score Comments 
You can delete an assignment score comment using the Score Inspector. 

How to Delete a Score Comments 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Select the assignment of the student you want to update. The assignment details 
appear in the Score Inspector window. 

5. Highlight the comment text in the Comment field and press DELETE. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's assignment or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. The blue circular “C” no longer appears within 
the selected student assignment score field. 
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Add Final Grade Comments 
When entering a final grade comment, you can use plain text, HTML, or a combination of 
both. After you enter the final grade comment, it appears on the Quick Lookup page in 
PowerSchool. In order for parents and students to view this information on the PowerSchool 
Parent Portal, you need to publish it. 

How to Add a Final Grade Comment 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Select the final grade of the student you want to update. The final grade details 
appear in the Score Inspector window. 

5. Manually enter final grade comments in the Comment field or click Comment Bank 
to select one or more predefined comments. 

Note: For additional entry options, see Quick Entry Tips. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's final grade or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. A blue circular “C” appears within the selected 
student final grade field. 

Edit Final Grade Comments 
You can edit a final grade comment using the Score Inspector. 

How to Edit a Final Grade Comment 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Select the final grade of the student you want to update. The final grade details 
appear in the Score Inspector window. 

5. Manually enter final grade comments in the Comment field or click Comment Bank 
to select one or more predefined comments. 

Note: For additional entry options, see Quick Entry Tips. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's final grade or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. A blue circular “C” appears within the selected 
student final grade field. 
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Delete Final Grade Comments 
You can delete a final grade comment using the Score Inspector. 

How to Delete a Final Grade Comment 

1. Select a class from the Classes pane. 

2. Click the Scoresheet tab. The Scoresheet window appears. 

3. Open the Score Inspector. The Score Inspector window appears. 

4. Select the final grade of the student you want to update. The final grade details 
appear in the Score Inspector window. 

5. Highlight the comment text in the Comment field and press DELETE. 

6. Use the Previous and Next arrows to repeat for each student, if applicable. 

Note: Click Clear to discard changes made to the selected student's final grade or 
click Close to close the Score Inspector window. 

7. Click Save on the Scoresheet window. The blue circular “C” no longer appears within 
the selected student final grade field. 
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Reports 

About Reports 
You can print various reports whenever you want, without having to wait for your 
PowerSchool or school administrator to do it for you. PowerTeacher gradebook offers a 
selection of reports to assist you in daily classroom activities, as well as with assessing 
student performance. Using the Reports window, you can generate reports for all students 
who are enrolled in a class, for all students who are enrolled in all your classes, or for a 
specific set, group, individual student, selection of students, or any combination. For more 
information, see Student Groups. 

Report Format 

When generating reports, you can choose from three output formats: 

Feature Description 

PDF A cross-platform Portable Document Format (PDF) file that can 
be read and printed by a PDF reader, such as Adobe Acrobat 
Reader or Preview. 

Note: Reports generated using this format have a file 
extension of .pdf, such as reportname.pdf. 

HTML A file that can be read by a browser such as Safari or Internet 
Explorer. 

Note: Reports generated using this format have a file 
extension of .html, such as reportname.html. 

Export (CSV) A text file consisting of the data, separated by commas. This 
file can be opened with Excel or another spreadsheet 
application. 

Note: Reports generated using this format have a file 
extension of .csv, such as reportname.csv. 

Format options vary depending on the report. Generate reports can be made available in 
electronic or hard copy format. 

When opening a report, PowerTeacher gradebook looks to the default browser to determine 
how to handle the report. If a report does not open automatically, either the application 
needed to open the report does not exist or the default browser does not know how to 
handle the report. If this happens, run the report again and save it to your desktop. 

For Mac, right-click on the file and choose Get Info. The report info window appears. 
Expand the Open with section by clicking the down arrow. Choose the default application 
you want to use to open all reports using a given file extension from the pop-up menu and 
click Change All. A prompt appears verifying your selection, click Continue. 

For Windows, right-click on the file and choose Open With > Choose Program. The Open 
With window appears. Select the default application you want to use to open all reports 
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using a given file extension from the Programs list. Select the Always use the selected 
program to open this kind of file checkbox and click OK. 

Run the Attendance Grid Report 
Run the Attendance Grid report to generate a student and date grid for taking attendance. 
You can use this report to take attendance at field trips or other out-of-classroom events. 
You can also use it as a convenient roster for taking notes during student presentations or 
to track class participation. 

How to Run the Attendance Grid Report 

1. Select a class from the Classes pane. 

2. Click the Reports tab. The Reports window appears. 

3. Click Attendance Grid. The Attendance Grid window appears. 

4. To use the default report settings, skip to Step 5. Otherwise, edit the information as 
needed. For detailed information, see the Reports Window section. 

5. Click Run Report. The Report Complete window appears. 

6. To open the report: 

a. Select the Open Report option. 

b. Click OK. The report results display based on the parameters you selected. 

7. To save the report to a file: 

a. Select the Save Report option. 

b. Click OK. The Save Report window appears. 

c. Enter a file name of the report in the Save As field. By default, this field 
populates with Attendance Grid. 

d. Choose the location where you want to save the report from the Where pop-
up menu. 

Note: Desktop appears as the default setting. If you select a different 
location, that location then becomes the new default setting. 

e. Click Save. The Attendance Grid Report Complete window appears. 

f. Click OK. 

g. To view the report, navigate to where the report was saved and open it. The 
report results display based on the parameters you selected. 

Run the Category Total Report 
Run the Category Total report to generate a summary of the assignment category totals for 
each reporting term. It can be grouped by student and class. This report displays graphs for 
assignment count and average score per category. 
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How to Run Category Total Report 

1. Select a class from the Classes pane. 

2. Click the Reports tab. The Reports window appears. 

3. Click Run Category Total. The Category Total Report window appears. 

4. To use the default report settings, skip to Step 5. Otherwise, edit the information as 
needed. For detailed information, see the Reports Window section. 

5. Click Run Report. The Report Complete window appears. 

6. To open the report: 

a. Select the Open Report option. 

b. Click OK. The report results display based on the parameters you selected. 

7. To save the report to a file: 

a. Select the Save Report option. 

b. Click OK. The Save Report window appears. 

c. Enter a file name of the report in the Save As field. By default, this field 
populates with Category Total Report. 

d. Choose the location where you want to save the report from the Where pop-
up menu. 

Note: Desktop appears as the default setting. If you select a different 
location, that location then becomes the new default setting. 

e. Click Save. The Attendance Grid Report Complete window appears. 

f. Click OK. 

g. To view the report, navigate to where the report was saved and open it. The 
report results display based on the parameters you selected. 

Run the Final Grade and Comment Verification Report 
Run the Final Grade and Comment Verification report to generate a list of final grades and 
teacher comments for students grouped by section, then by reporting term. 

How to Run the Final Grade and Comment Verification Report 

1. Select a class from the Classes pane. 

2. Click the Reports tab. The Reports window appears. 

3. Click Final Grade and Comment Verification. The Final Grade and Comment 
Verification window appears. 

4. To use the default report settings, skip to Step 5. Otherwise, edit the information as 
needed. For detailed information, see the Reports Window section. 

5. Click Run Report. The Report Complete window appears. 

6. To open the report: 

a. Select the Open Report option. 

b. Click OK. The report results display based on the parameters you selected. 
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7. To save the report to a file: 

a. Select the Save Report option. 

b. Click OK. The Save Report window appears. 

c. Enter a file name of the report in the Save As field. By default, this field 
populates with Final Grade and Comment Verification. 

d. Choose the location where you want to save the report from the Where pop-
up menu. 

Note: Desktop appears as the default setting. If you select a different 
location, that location then becomes the new default setting. 

e. Click Save. The Final Grade and Comment Verification Report Complete 
window appears. 

f. Click OK. 

g. To view the report, navigate to where the report was saved and open it. The 
report results display based on the parameters you selected. 

Run the Individual Student Report 
Run the Individual Student report to generate section scores by assignment, and the final 
grade for each reporting term, listed in a one page per student layout. 

How to Run the Individual Student Report 

1. Select a class from the Classes pane. 

2. Click the Reports tab. The Reports window appears. 

3. Click Individual Student Report. The Individual Student Report window 
appears. 

4. To use the default report settings, skip to Step 5. Otherwise, edit the information as 
needed. For detailed information, see the Reports Window section. 

5. Click Run Report. The Report Complete window appears. 

6. To open the report: 

a. Select the Open Report option. 

b. Click OK. The report results display based on the parameters you selected. 

7. To save the report to a file: 

a. Select the Save Report option. 

b. Click OK. The Save Report window appears. 

c. Enter a file name of the report in the Save As field. By default, this field 
populates with Individual Student. 

d. Choose the location where you want to save the report from the Where pop-
up menu. 

Note: Desktop appears as the default setting. If you select a different 
location, that location then becomes the new default setting. 

e. Click Save. The Individual Student Report Complete window appears. 
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f. Click OK. 

g. To view the report, navigate to where the report was saved and open it. The 
report results display based on the parameters you selected. 

Run the Missing Assignment Report 
Run the Missing Assignments report to generate a list of assignments that have not been 
scored. The report can be generated for assignments that are missing per assignment or per 
student. 

How to Run the Missing Assignment Report 

1. Select a class from the Classes pane. 

2. Click the Reports tab. The Reports window appears. 

3. Click Missing Assignment. The Missing Assignment window appears. 

4. To use the default report settings, skip to Step 5. Otherwise, edit the information as 
needed. For detailed information, see the Reports Window section. 

5. Click Run Report. The Report Complete window appears. 

6. To open the report: 

a. Select the Open Report option. 

b. Click OK. The report results display based on the parameters you selected. 

7. To save the report to a file: 

a. Select the Save Report option. 

b. Click OK. The Save Report window appears. 

c. Enter a file name of the report in the Save As field. By default, this field 
populates with Missing Assignment. 

d. Choose the location where you want to save the report from the Where pop-
up menu. 

Note: Desktop appears as the default setting. If you select a different 
location, that location then becomes the new default setting. 

e. Click Save. The Missing Assignment Report Complete window appears. 

f. Click OK. 

g. To view the report, navigate to where the report was saved and open it. The 
report results display based on the parameters you selected. 

Run the Scoresheet Report 
Run the Scoresheet report to generate a spreadsheet-style summary of student grade and 
assignment date. You can use this report to view final grades for all reporting terms and 
assignments that are within a specific date range, for all students. 
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How to Run the Scoresheet Report 

1. Select a class from the Classes pane. 

2. Click the Reports tab. The Reports window appears. 

3. Click Scoresheet. The Scoresheet window appears. 

4. To use the default report settings, skip to Step 5. Otherwise, edit the information as 
needed. For detailed information, see the Reports Window section. 

5. Click Run Report. The Report Complete window appears. 

6. To open the report: 

a. Select the Open Report option. 

b. Click OK. The report results display based on the parameters you selected. 

7. To save the report to a file: 

a. Select the Save Report option. 

b. Click OK. The Save Report window appears. 

c. Enter a file name of the report in the Save As field. By default, this field 
populates with Scoresheet. 

d. Choose the location where you want to save the report from the Where pop-
up menu. 

Note: Desktop appears as the default setting. If you select a different 
location, that location then becomes the new default setting. 

e. Click Save. The Scoresheet Report Complete window appears. 

f. Click OK. 

g. To view the report, navigate to where the report was saved and open it. The 
report results display based on the parameters you selected. 

Run the Student Multi-Section Report 
Run the Student Multi-Section report to generate section scores by assignment, and the 
final grade for each reporting term, listed in a one page per student layout. This report is 
similar to the Individual Student Report, but is able to present information from any section 
that the student is taking. 

Note: This report only displays data entered by teachers who use PowerTeacher gradebook. 
If other teachers are entering assignments and scores through other applications, such as 
PowerGrade, then that data does not display. 

How to Run the Student Multi-Section Report 

1. Select a class from the Classes pane. 

2. Click the Reports tab. The Reports window appears. 

3. Click Student Multi-Section Report. The Student Multi-Section Report window 
appears. 

4. To use the default report settings, skip to Step 5. Otherwise, edit the information as 
needed. For detailed information, see the Reports Window section. 
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5. Click Run Report. The Report Complete window appears. 

6. To open the report: 

a. Select the Open Report option. 

b. Click OK. The report results display based on the parameters you selected. 

7. To save the report to a file: 

a. Select the Save Report option. 

b. Click OK. The Save Report window appears. 

c. Enter a file name of the report in the Save As field. By default, this field 
populates with Scoresheet. 

d. Choose the location where you want to save the report from the Where pop-
up menu. 

Note: Desktop appears as the default setting. If you select a different 
location, that location then becomes the new default setting. 

e. Click Save. The Scoresheet Report Complete window appears. 

f. Click OK. 

g. To view the report, navigate to where the report was saved and open it. The 
report results display based on the parameters you selected. 

Run the Student Roster Report 
Run the Student Roster report to generate a summary of student demographic information 
on a student-by-student basis. When generating this report, you can specify which columns 
of student data to list on the report, and in what order. In addition, you can add up to six 
blank columns with customizable column headings. 

How to Run the Student Roster Report 

1. Select a class from the Classes pane. 

2. Click the Reports tab. The Reports window appears. 

3. Click Student Roster. The Student Roster window appears. 

4. To use the default report settings, skip to Step 5. Otherwise, edit the information as 
needed. For detailed information, see the Reports Window section. 

5. Click Run Report. The Report Complete window appears. 

6. To open the report: 

a. Select the Open Report option. 

b. Click OK. The report results display based on the parameters you selected. 

7. To save the report to a file: 

a. Select the Save Report option. 

b. Click OK. The Save Report window appears. 

c. Enter a file name of the report in the Save As field. By default, this field 
populates with Student Roster. 
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d. Choose the location where you want to save the report from the Where pop-
up menu. 

Note: Desktop appears as the default setting. If you select a different 
location, that location then becomes the new default setting. 

e. Click Save. The Student Roster Complete window appears. 

f. Click OK. 

g. To view the report, navigate to where the report was saved and open it. The 
report results display based on the parameters you selected. 
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Quit PowerTeacher Gradebook 

About Quitting 
When you are finished working in PowerTeacher gradebook, it is important to quit the 
application, which you can do from any gradebook window. Additionally, when you are 
finished working in PowerTeacher, it is important to log out, which you can do from any 
PowerTeacher page. 

Quit PowerTeacher Gradebook 
To quit PowerTeacher gradebook, use the gradebook menu bar. 

How to Quit PowerTeacher Gradebook 

1. From the gradebook menu bar, choose File > Save. 

2. From the gradebook menu bar, choose PowerTeacher Gradebook > Quit 
PowerTeacher Gradebook. 

Note: If you have unsaved changes, a window indicates the changes that you made. 
To save the changes, click Yes. Otherwise, click No. 

Log Out of PowerTeacher 
To log out of PowerTeacher, use the navigation bar. 

How to Log Out of PowerTeacher 

Click Logout in the navigation bar. The Log In page appears. You must enter your 
username and password again to redisplay the PowerTeacher start page. 
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Appendix: Field Description Tables  

Add Web Link Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Field Description 

URL Enter the Web address for this link. 

Link Text Enter the text to display for the link. 

Open this link in a new 
browser window 

Select the checkbox to launch a new browser window 
when the link is clicked. 

Cancel Click to discard any changes you made and close the 
window. 

OK Click to save your changes. 

Assignments Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Assignments 

Field Description 

Filter By Reporting 
Term 

To view assignments with a due date that falls within a 
specific reporting term, week, or month, choose a 
reporting term, week, or month from the pop-up menu. 
The Assignments window refreshes and displays only those 
assignments with a due date that falls within that selected 
reporting term, week, or month. 

Filter By Category To view assignments with a due date that belong to a 
specific category, choose a category from the pop-up 
menu. The Assignments window refreshes and displays 
only those assignments that belong to the selected 
category. 

Name The assignment name appears. 

Note: Click the column heading to sort in descending 
order. Click again to sort in ascending order. 

Abbreviation The assignment abbreviation appears. 

Note: Click the column heading to sort in descending 
order. Click again to sort in ascending order. 
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Field Description 

Category The category by which the assignment is grouped appears. 

Note: Click the column heading to sort in descending 
order. Click again to sort in ascending order. 

Points Possible The number of points possible for the assignment appears. 

Note: Click the column heading to sort in descending 
order. Click again to sort in ascending order. 

Weight The weight of the assignment appears. 

Note: Click the column heading to sort in descending 
order. Click again to sort in ascending order. 

Date Due The date the assignment is due appears. 

Note: Click the column heading to sort in descending 
order. Click again to sort in ascending order. 

Plus (+) Click to create a new a new assignment. The New 
Assignment window appears. See Assignment Details: 
Assignment Tab and Assignment Details: Publish 
Tab. 

Minus (-) Select an assignment and click to delete. The Delete 
Assignment window appears. 

Note: If an assignment does not have scores, the Delete 
Assignment window states, "Are you sure you want to 
delete assignment [name]?"  

If an assignment has scores, the Delete Assignment 
window states, "This assignment has scores. Are you sure 
you want to delete assignment [name] and all associated 
scores?"  

Click Yes. The assignment no longer appears on the 
Assignment window. 

Assignment Details: Assignment Tab 

Field Description 

Name Enter the assignment name. 

Abbreviation Enter the assignment abbreviation. 

Note: After you have entered an assignment Name and 
advanced to another field, the Abbreviation field 
automatically populates with the name of the assignment 
(up to 30 characters). 

Category Use the pop-up menu to choose the category by which the 
assignment should be grouped. 

Score Type If a category is selected, the score type defaults to the 
category score type. 

Use the pop-up menu to choose the method by which the 
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Field Description 

assignment should be recorded: Points, Percentage, or 
Letter Grade. 

Points Possible If a category is selected, the points possible defaults to the 
category points possible. 

Enter the number of points possible for the assignment. 

Weight Enter the weight of the assignment. The system multiplies 
both the assignment's points possible and the students' 
scores by this weight when calculating final grades. 

Date Due Enter the date the assignment is due by doing one of the 
following: 

• Leave the default date. 

• Enter a different date using the format 
mm/dd/yyyy. 

• Click the Calendar icon and select the date. 

• Clear the field. 

Note: This field auto-populates with a date based on the 
date of entry. If the date of entry is before the section 
start date, the field populates with the section start date. 
If the date of entry is after the section end date, the field 
populates with the section end date. If the date of entry 
falls between the section's start and end dates, the field 
populates with today's date. 

Include in Final Grade If a category is selected, the checkbox defaults based on 
the category. 

Select the checkbox to include this assignment in final 
grade calculation. 

Description Detailed information about the assignment. This 
information appears on the Quick Lookup page in 
PowerSchool and on the PowerSchool Parent Portal when 
the assignment is published. 

Enter the description of the assignment using plain text, 
HTML, or a combination of both. 

For example: [Plain text] Analyze and write 500-word 
essay on Herman Melville’s Billy Bud. What point is the 
author trying to make? Support your idea with several 
aspects of the story - plot, characterization, setting, irony, 
symbolism, imagery, etc. Show how these different 
aspects work together to convey the message. Please refer 
to the following resources: [HTML describing the 
resources, showing pictures, and links to these sites.] 

Revert Click to discard any changes you made. 

Note: This button appears shaded until information is 
entered. 

Save Click to save your changes. 

Note: This button appears shaded until information is 
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Field Description 

entered. 

Assignment Details: Publish Tab 

Field Description 

Publish Assignment In order for parents and students to view assignment 
information on the PowerSchool Parent Portal, choose one 
of the following from the pop-up menu: 

• Immediately 

• On Specific Date 

• Days Before Due 

• On Due Date 

If you do not want make an assignment available on the 
PowerSchool Parent Portal, you can elect to never publish 
the assignment by choosing Never from the pop-up 
menu. 

Note: If an assignment is included in calculating final 
grades and impacts the final grade, it must be published in 
order for parents and students to view. The pop-up menu 
cannot be set to Never. For more information, see 
Publish Assignments. 

On Date If you selected On Specific Date, enter the date the 
assignment should appear in the field using the format 
mm/dd/yyyy, or click the Calendar icon and select the 
date. 

Days Before Due If you selected Days Before Due, enter the number of 
days the assignment should appear prior to the date that 
it is due in the field. 

Publish Scores Select the checkbox to publish the assignment score. If 
you elect to publish assignment scores, parents and 
students can view this information on the PowerSchool 
Parent Portal. 

Deselect the checkbox to not publish the assignment 
score. If you elect not to publish assignment scores, 
parents and students cannot view this information on the 
PowerSchool Parent Portal. 

Revert Click to discard any changes you made. 

Note: This button appears shaded until information is 
entered. 

Save Click to save your changes. 

Note: This button appears shaded until information is 
entered. 
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Categories Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Categories 

Field Description 

[Categories] A list of categories appears on the left side of the window. 
If necessary, use the scroll bar to view the entire list of 
categories. 

Plus (+) Click to create a new a new assignment category. The new 
category appears on the left side of the window. See 
Category Details. 

Minus (-) Select an assignment category and click to delete. The 
Categories window appears without the deleted category. 

Note: If category has assignments or is used in weighting, 
the Alert window appears, displaying the message, "Unable 
to delete category because it has associated assignments." 
Click OK to close the window. 

Category Details 

Field Description 

Name Enter the category name. 

Abbreviation Enter the category abbreviation. 

Color Use the pop-up menu to choose the color used on the 
Scoresheet and Assignments windows to identify 
assignments within this category. 

Points Possible Enter the default number of points possible for each 
assignment in this category. 

You can modify this information for individual assignments 
as needed. 

Score Type Use the pop-up menu to choose the default method by 
which assignments in this category should be recorded: 
Points, Percentage, or Letter Grade. 

You can modify this information for individual assignments 
as needed. 

Include in Final Grade Select the checkbox to include assignments in this 
category when calculating final grades. 

You can modify this information for individual assignments 
as needed. 
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Field Description 

Description Enter the description of the category using plain text, 
HTML, or a combination of both. This information appears 
on the Quick Lookup page in PowerSchool and on the 
PowerSchool Parent Portal when an assignment using this 
category is published. 

For example: [Plain text] This category is worth 20% of 
the student’s grade. Homework assignments are due every 
Monday and are worth 10 points each. Students are 
allowed to miss only one. Missing more than one 
assignment may significantly affect the student’s over-all 
grade. 

Please refer to the following resources: [HTML describing 
the resources, showing pictures, and links to these sites.] 

Cancel Click to discard any changes you made and close the 
window. 

Close Click to save your changes. 

Class Information Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Field Description 

Course Name The name of the class appears. 

Section Number The section number of the class appears. 

Periods/Days The period/day combination for the class appears. 

Room The room number for the class appears. 

Term The term for the class appears. 

Start The first day of class appears. 

End The last day of class appears. 

Grade Scale The name of the grade scale associated with the class 
appears. 

Custom Display Name Enter the name of the section as you want it to appear in 
the class list. 

Note: The Choose the Name used to distinguish 
sections in the class list option on the Preferences 
window must be set to Custom Display Name in order 
for the custom name to appear in the class list. 

Description Enter detailed information about the class using text 
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Field Description 

and/or HTML, such as: 

[Plain text] This class focuses upon writing essays for 
a variety of purposes; addressing different audience 
types; experimenting with different forms of 
expression; practicing techniques for developing and 
arranging ideas; and building vocabulary, grammar, 
syntax, and related skills. 

Please refer to the following resources: [HTML 
describing the resources, showing pictures, and links 
to these sites.] 

This information appears on the Quick Lookup page in 
PowerSchool and on the PowerSchool Parent Portal. 

Add Web Link Click to add a Web link to the class description. The Add 
Web Link window appears. 

Revert Click to discard any changes you made. 

Note: This button appears shaded until information is 
entered. 

Save Click to save your changes. 

Note: This button appears shaded until information is 
entered. 

Classes Pane 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Field Description 

[Term Selector] When you first launch PowerTeacher gradebook, the 
current full year term appears. The pop-up menu displays 
current, future, and past year terms, as well as any lower 
level terms within a term. 

Choose a term from the pop-up menu. Classes for the 
selected term appear. 

[Classes] When you first launch PowerTeacher gradebook, the Class 
List displays classes for the current term. The first class in 
your daily schedule appears highlighted. Information that 
appears in the class list is defined by your section 
preferences. 

Select a class. The window in which you were last working 
refreshes for the selected class. 

Note: Information that appears in the class list is defined 
by your section preferences. For more information, see 
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Field Description 

Define Section Preferences. 

Copy Assignment Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Copy Assignment 

Field Description 

Copy Assignment Source assignment and class. 

[Term] Choose a term from the pop-up menu. Classes for the 
selected term appear. 

Classes Select the checkbox to copy the assignment to all the 
classes within the selected term. Note checkmarks appear 
next to each class. Alternately, deselect the checkbox to 
clear checkmarks from each class.  

[Classes] Select individual checkboxes for only those classes you 
want to copy the assignment to. Select the same class 
checkbox to copy an assignment within a class. 

Due Date Choose the date the assignment is due from the pop-up 
menu: Existing, Today, or Custom. 

If you select Custom, enter a different date using the 
format mm/dd/yyyy or click the Calendar icon and select 
the date. 

Note: If the preferred due date does not fall within the 
term of the class that the assignment is being copied to, 
the due date of the new assignment will be calculated 
based on the due date of the source assignment. 

Cancel Click to discard any changes you made and close the 
window. 

OK Click to save your changes. 

 

Fill Scores Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Field Description 

Would you like to fill 
empty scores or 

Select the Fill empty scores for the selected 
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Field Description 

replace all existing 
scores? 

assignment option to only fill empty scores. 

Select the Replace all scores for the selected 
assignment option to replace all scores. 

Scoring Type The method by which the assignment should is recorded: 
Points, Percentage, or Letter Grade. 

Collected Select the checkbox to indicate assignments have been 
collected. 

Late Select the checkbox to indicate assignments are late. 

Exempt Score Select the checkbox to indicate assignments are exempt. 

Missing Select the checkbox to indicate assignments are missing. 

Score Enter the score. 

Comment Manually enter score comments or click Comment Bank 
to select one or more predefined comments. 

Note: If using the Comment Bank, you can press and hold 
COMMAND (Mac) or CONTROL (Windows) to select 
multiple comments. When you have finished making your 
selections, click Insert Selected Comments and then 
click OK. 

Cancel Click to discard any changes you made and close the 
window. 

OK Click to save your changes. 

Grade Scales Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Field Description 

[Grade Scales] Grade scales entered by administrators associated to the 
classes taught by the teacher. 

Name Name of the selected grade scale. 

Grade Letter grade. 

Cutoff Percentage cutoff for the grade. 

Percent Percent value assigned to the grade. 

Description Description for the grade. 



 PowerTeacher Gradebook User Guide 

Appendix: Field Description Tables 73 

Grades Setup Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Reporting Terms 

Field Description 

Reporting Term Name of the reporting term. 

Start First day of the selected reporting term. 

End Last day of the selected reporting term. 

Reporting Term Details 

Note: Options appear enabled/disabled based on the selected reporting term and the 
method by which you calculate final grades. 

Field Description 

Calculate Final Grade 
Using 

Indicate the method by which you want to calculate final 
grades for the selected reporting term: 

• Select the Total points option to calculate final 
grades based on how many points a student has 
accumulated over the term divided by total points 
possible. 

• Select the Term weights option to calculate final 
grades based on the total points times the value (or 
weight) of each term. 

• Select the Category weights option to calculate 
final grades based on total points times the value 
(or weight) of each category or assignment. 

Number of low scores 
to discard 

If Total points is selected, enter the number of low 
scores you want to drop from the final grade calculation in 
the field. 

If Term weights is selected, this field appears shaded. 

If Category weights is selected, this field appears 
shaded. 

Name If Total points is selected, this field appears shaded. 

If Term weights is selected, the name of the reporting 
term appears. 

If Category weights is selected, the name of the 
category appears. 

Note: Click the column heading to sort in descending 
order. Click again to sort in ascending order. 
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Field Description 

Weight If Total points is selected, this field appears shaded. 

If Term weights is selected, the weight of the reporting 
term appears. 

If Category weights is selected, the weight of the 
category appears. 

The system multiplies both the assignment's points 
possible and the students' scores by this weight when 
calculating final grades. By default, each of these values 
are set to zero. Double-click the weight you want to edit 
and enter the new value in the editable text field. Up to 
two decimals may be entered. 

Note: Click the column heading to sort in descending 
order. Click again to sort in ascending order. 

Percent If Total points is selected, this field appears shaded. 

If Term weights or Category weights is selected, the 
percentage weight based for the final grade calculation 
appear. 

Note: Click the column heading to sort in descending 
order. Click again to sort in ascending order. 

Drop Low If Total points is selected, this field appears shaded. 

If Term weights is selected, this field appears as read-
only. 

If Category weights is selected, the number of low 
scores to drop appears. By default, this value is set to 
zero. Double-click the drop low value you want to edit and 
enter a new value in the editable text field. 

Note: Click the column heading to sort in descending 
order. Click again to sort in ascending order. 

Add Category If Total points is selected, this button does not appear. 

If Term weights is selected, this button does not appear. 

If Category weights is selected, click the button to add a 
category. The Select Categories window appears. Select 
the checkbox to each category you want to add. Click OK. 

Remove If Total points is selected, this button does not appear. 

If Term weights is selected, this button does not appear. 

If Category weights is selected, select the category you 
want to delete and click the button to remove a category. 

Revert Click to discard any changes you made. 

Note: This button appears shaded until information is 
entered. 
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Field Description 

Save Click to save your changes. 

Note: This button appears shaded until information is 
entered. 

Points Possible Has Changed Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Field Description 

Cancel Click to discard any changes you made and close the 
window. 

Adjust Scores Click to adjust them based on the new points possible. 

Keep Scores Click to keep the scores as-is. 

Preferences Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Grading Tab 

Field Description 

When calculating a 
grade the value should 
be 

Indicate how you want final grades to be calculated by 
selecting one of the following options: 

• Select Rounded to round the number up or down 
to the nearest decimal point specified. 

• Select Truncated to cut off the number at the 
specified number of places after the decimal. 

Store calculated 
grades with up to [ ] 
decimal places 

Choose the number of digits to appear after the decimal 
point from the pop-up menu. 

Final Grade Display Indicate how you want final grades to display on the 
Scoresheet by selecting none, one, or more of the 
following: 

• Letter Grade 

• Percent 

• Points Earned 

Final grades appear on the Scoresheet based on your 
selection.  
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Field Description 

Cancel Click to discard any changes you made and close the 
window. 

OK Click to save you changes. 

Section Tab 

Field Description 

Choose the Identifier 
used to distinguish 
sections in the class 
list 

Indicate how you want sections within the class list to 
appear by selecting one of the following options: 

• Section Period Day 

• Section Number 

Choose the Name used 
to distinguish sections 
in the class list 

Indicate how you want section names within the class list 
to appear by selecting one of the following options: 

• Course Name 

• Custom Display Name 

If Custom Display Name is selected, the text you enter 
in the Custom Display Name field on the Class 
Information window appears in the class list. 

Sort By Choose the order by which you want to sort the class list 
from the pop-up menu: 

• Period/Day 

• Section Number 

• Course Name 

Cancel Click to discard any changes you made and close the 
window. 

OK Click to save your changes. 

Report Complete Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Field Description 

Report: [Name of 
report] has been 
generated. Would you 
like to open the report 
or save it to a file? 

Do one of the following: 

• Select the Open report option to open the report. 

• Select the Save Report option to save the report 
to a file. 
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Field Description 

Cancel Click to discard any changes you made and close the 
window. 

OK Click to save your changes. 

 

Reports Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Global Reporting Layout 

Field Description 

Report Title To change the report title, enter a different report title. 

Page Breaks Select the On Sections checkbox to insert a page break 
between each section within the report. This option is 
available when generating a report for all classes. 

Select the On Students checkbox to insert a page break 
between each student within the report. This option is 
available when generating a report where the report is 
able to report one page per student. 

Select the On Reporting Terms checkbox to insert a 
page break between each reporting term within the report. 
This option is available when generating a report where 
the report is able to display data separately for each 
reporting term. 

Note: Options vary from report to report and appear 
enabled/disabled based on the selected report criteria. To 
view a checkbox's report criteria, place your cursor on the 
checkbox. 

Top Note To add a header row to the report, select the include 
checkbox. When included, the header row appears at the 
top of each page of the report. 

Select the bold checkbox if you want the header row to 
appear in bold formatting. 

Enter up to five lines of header text in the text field. 

Note: If you enter header text and run the report, the text 
is available the next time you run the report. 

Bottom Note To add a footer row to the report, select the include 
checkbox. When included, the footer row appears at the 
bottom of each page of the report. 

Select the bold checkbox if you want the footer row to 
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Field Description 

appear in bold formatting. 

Enter up to five lines of footer text in the text field. 

Note: If you enter footer text and run the report, the text 
is available the next time you run the report. 

Signature Line To add a signature line, select the include checkbox. 
When included, the parent signature line appears at the 
bottom of each page of the report. 

Note: If the report includes a bottom note, the signature 
line appears above it. 

Run Report Click to open the report or save the report. The Report 
Complete window appears. 

Attendance Grid Report 

Field Description 

Name The name of the report. 

Description A description of the report. 

Sections Select the option indicating the sections for which you 
want to run the report: 

• Select Selected Class to generate a report for a 
class. 

• Select Active Classes to generate a report for all 
classes. 

Note: If running this report for multiple sections, courses 
are identified by course name and section number, instead 
of course name and expression. 

Students Select the option indicating the students for which you 
want to run the report: 

• Select Enrolled Students to generate a report for 
all students who are enrolled. 

• Select Selected Groups and/or Students and 
then select a set, group, individual student, 
selection of students, or any combination from the 
Students Group pane. 

Note: To generate a report for a set, group, individual 
student, selection of students, or any combination, use 
student groups. 

Student Field Select the option indicating which student field you want 
to include in the report: 

• Student Name 
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Field Description 

• Student Number 

If Student Number is selected, use the Sort By pop-up 
menu to indicate the students number order: 

• Select Number to sort student numbers 
sequentially. 

• Select Random to sort student numbers arbitrarily. 

Note: If Student Name is selected, the student's name 
may appear truncated if it exceeds the width of the report 
column. 

No Dates Select the checkbox to run the report based on number of 
days for which you want to take attendance rather than 
actual dates. 

Note: Column headings appear blank. 

# Of Days If the No Dates checkbox is selected, choose the number 
of days for which you want to take attendance from the 
pop-up menu. 

Note: The number of days indicates the numbers of 
columns that appear in the report. 

Current Week Select the checkbox to run the report for a five-day span 
starting with Monday of the current week. Note the Start 
Date and End Date fields become populated with this 
week’s date range. 

Deselect the checkbox to run the report for a six-day span, 
such as Monday to Monday, starting with today skipping 
Saturday and Sunday. 

Note: If the No Dates checkbox is selected, this option is 
not available. 

Start Date To run the report for a date range other than this week, 
enter the start date for the date range using the format 
mm/dd/yyyy or click the Calendar icon to select a date. 

Note: If the No Dates checkbox is selected, this option is 
not available. 

End Date To run the report for a date range other than this week, 
enter the end date for the date range using the format 
mm/dd/yyyy or click the Calendar icon to select a date. 

Note: If the No Dates checkbox is selected, this option is 
not available. 
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Category Total Report 

Field Description 

Name The name of the report 

Description A description of the report. 

Report Layout Select the option indicating how you want to group report 
output: 

• Totals by Section 

• Totals by Student 

Output Type Select the option indicating the format in which you want 
to receive the report: 

• PDF 

• Export (CSV) 

Sections Select the option indicating the sections for which you 
want to run the report: 

• Select Selected Class to generate a report for a 
class. 

• Select Active Classes to generate a report for all 
classes. 

Note: If running this report for multiple sections, courses 
are identified by course name and section number, instead 
of course name and expression. 

Students Select the option indicating the students for which you 
want to run the report: 

• Select Enrolled Students to generate a report for 
all students who are enrolled. 

• Select Selected Groups and/or Students and 
then select a set, group, individual student, 
selection of students, or any combination from the 
Students Group pane. 

Note: To generate a report for a set, group, individual 
student, selection of students, or any combination, use 
student groups. 

Student Field Select the option indicating which student field you want 
to include in the report: 

• Student Name 

• Student Number 

If Student Number is selected, use the Sort By pop-up 
menu to indicate the students number order: 

• Select Number to sort student numbers 
sequentially. 
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Field Description 

• Select Random to sort student numbers arbitrarily. 

Note: If Student Name is selected, the student's name 
may appear truncated if it exceeds the width of the report 
column. 

Reporting Term Choose ALL or the specific term for which you want to run 
this report from the pop-up menu. 

Final Grade and Comment Verification Report 

Field Description 

Name The name of the report 

Description A description of the report. 

Output Type Select the option indicating the format in which you want 
to receive the report: 

• PDF 

• HTML 

• Export (CSV) 

Sections Select the option indicating the sections for which you 
want to run the report: 

• Select Selected Class to generate a report for a 
class. 

• Select Active Classes to generate a report for all 
classes. 

Note: If running this report for multiple sections, courses 
are identified by course name and section number, instead 
of course name and expression. 

Students Select the option indicating the students for which you 
want to run the report: 

• Select Enrolled Students to generate a report for 
all students who are enrolled. 

• Select Selected Groups and/or Students and 
then select a set, group, individual student, 
selection of students, or any combination from the 
Students Group pane. 

Note: To generate a report for a set, group, individual 
student, selection of students, or any combination, use 
student groups. 

Student Fields Select the option indicating which student field you want 
to include in the report: 
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Field Description 

• Student Name 

• Student Number 

If Student Number is selected, use the Sort By pop-up 
menu to indicate the students number order: 

• Select Number to sort student numbers 
sequentially. 

• Select Random to sort student numbers arbitrarily. 

Note: If Student Name is selected, the student's name 
may appear truncated if it exceeds the width of the report 
column. 

Include Select the checkboxes indicating which final grades you 
want to include in the report, as well as if you want to 
include comments: 

• Points 

• Grades 

• Percent 

• Comment 

Reporting Term Choose ALL or the specific term for which you want to run 
this report from the pop-up menu. 

Individual Student Report 

Field Description 

Name The name of the report 

Description A description of the report. 

Output Type Select the option indicating the format in which you want 
to receive the report: 

• PDF 

• HTML 

• Export (CSV) 

Sections Select the option indicating the sections for which you 
want to run the report: 

• Select Selected Class to generate a report for a 
class. 

• Select Active Classes to generate a report for all 
classes. 

If Active Classes is selected, use the Order By pop-up 
menu to indicate the report sort order: 
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Field Description 

• Select Student Name to sort alphabetically by 
students' name (last, first) across all sections. 

• Select Section, Student to sort by section and 
then alphabetically by students' name (last, first) 
for each section. 

Note: If running this report for multiple sections, courses 
are identified by course name and section number, instead 
of course name and expression. 

Students Select the option indicating the students for which you 
want to run the report: 

• Select Enrolled Students to generate a report for 
all students who are enrolled. 

• Select Selected Groups and/or Students and 
then select a set, group, individual student, 
selection of students, or any combination from the 
Students Group pane. 

Note: To generate a report for a set, group, individual 
student, selection of students, or any combination, use 
student groups. 

Student Field Select the option indicating which student field you want 
to include in the report: 

• Student Name 

• Student Number 

If Student Number is selected, use the Sort By pop-up 
menu to indicate the students number order: 

• Select Number to sort student numbers 
sequentially. 

• Select Random to sort student numbers arbitrarily. 

Note: If Student Name is selected, the student's name 
may appear truncated if it exceeds the width of the report 
column. 

Abbreviate Select the Assignment checkbox to include assignment 
abbreviations instead of assignment names. 

Select the Categories checkbox to include category 
abbreviations instead of category names. 

Include Select the Final Grades checkbox to include all final 
grades for a student in the report. 

Select the Assignment Scores checkbox to include all 
assignment scores for a student in the report. 

If Assignment Scores is selected, select the Score 
Comments checkbox to include all assignment score 
comments for a student in the report. 
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Select the Category Summary checkbox to include a 
summary of assignment categories in the report. 

Date Range Choose the date range for which you want to run this 
report from the pop-up menu: 

• Manual 

• ALL 

• [Reporting Term] 

• This Week 

• This Month 

• Last Week 

• Last Month 

If you chose a specific reporting term, use the second pop-
up menu to indicate if you want to run the report for This 
term only or for This term and lower terms. 

Start Date If you chose Manual for Date Range, enter the start date 
for the date range using the format mm/dd/yyyy or click 
the Calendar icon to select a date. 

End Date If you chose Manual for Date Range, enter the end date 
for the date range using the format mm/dd/yyyy or click 
the Calendar icon to select a date. 

Missing Assignment Report 

Field Description 

Name The name of the report 

Description A description of the report. 

Output Type Select the option indicating the format in which you want 
to receive the report: 

• PDF 

• HTML 

• Export (CSV) 

Report Layout Select the option indicating how you want to group report 
output: 

• By Student 

• By Assignment 

Marked Missing Select the option indicating the assignments for which you 
want to run the report: 
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Field Description 

• Select Unrecorded Scores to generate a report 
for unscored assignments. 

• Select Missing Indicator to generate a report for 
assignments marked as missing. 

Sections Select the option indicating the sections for which you 
want to run the report: 

• Select Selected Class to generate a report for a 
class. 

• Select Active Classes to generate a report for all 
classes. 

If Active Classes is selected, use the Order By pop-up 
menu to indicate the report sort order: 

• Select Student Name to sort alphabetically by 
students' name (last, first) across all sections. 

• Select Section, Student to sort by section and 
then alphabetically by students' name (last, first) 
for each section. 

Note: If running this report for multiple sections, courses 
are identified by course name and section number, instead 
of course name and expression. 

Students Select the option indicating the students for which you 
want to run the report: 

• Select Enrolled Students to generate a report for 
all students who are enrolled. 

• Select Selected Groups and/or Students and 
then select a set, group, individual student, 
selection of students, or any combination from the 
Students Group pane. 

Note: To generate a report for a set, group, individual 
student, selection of students, or any combination, use 
student groups. 

Student Field Select the option indicating which student field you want 
to include in the report: 

• Student Name 

• Student Number 

If Student Number is selected, use the Sort By pop-up 
menu to indicate the students number order: 

• Select Number to sort student numbers 
sequentially. 

• Select Random to sort student numbers arbitrarily. 

Note: If Student Name is selected, the student's name 
may appear truncated if it exceeds the width of the report 
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Field Description 

column. 

Start Date Enter the start date for the date range using the format 
mm/dd/yyyy or click the Calendar icon to select a date. 

End Date Enter the end date for the date range using the format 
mm/dd/yyyy or click the Calendar icon to select a date. 

Scoresheet Report 

Field Description 

Name The name of the report 

Description A description of the report. 

Output Type Select the option indicating the format in which you want 
to receive the report: 

• PDF 

• Export (CSV) 

Sections Select the option indicating the sections for which you 
want to run the report: 

• Select Selected Class to generate a report for a 
class. 

• Select Active Classes to generate a report for all 
classes. 

Note: If running this report for multiple sections, courses 
are identified by course name and section number, instead 
of course name and expression. 

Students Select the option indicating the students for which you 
want to run the report: 

• Select Enrolled Students to generate a report for 
all students who are enrolled. 

• Select Selected Groups and/or Students and 
then select a set, group, individual student, 
selection of students, or any combination from the 
Students Group pane. 

Note: To generate a report for a set, group, individual 
student, selection of students, or any combination, use 
student groups. 

Student Field Select the option indicating which student field you want 
to include in the report: 

• Student Name 

• Student Number 
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If Student Number is selected, use the Sort By pop-up 
menu to indicate the students number order: 

• Select Number to sort student numbers 
sequentially. 

• Select Random to sort student numbers arbitrarily. 

Note: If Student Name is selected, the student's name 
may appear truncated if it exceeds the width of the report 
column. 

Category Choose ALL or a specific category for which you want to 
run this report from the pop-up menu.  

Assignment Display Select the option indicating how you want assignments to 
appear in the report: 

• Assignment Name 

• Assignment Abbreviation 

Items To Include Select the checkboxes indicating which scores you want 
included in the report: 

• Final Grades 

• Assignments 

If the Final Grade checkbox is selected, choose a final 
grade term from the pop-up menu. Only final grades for 
that selected term and any lower level terms within that 
term appear on the report. For example, if you choose S1, 
Q1 and Q2 will also be included in the report.  

Date Range Choose the date range for which you want to run this 
report from the pop-up menu: 

• Manual 

• [Reporting term] 

• This Week 

• This Month 

• Last Week 

• Last Month 

Start Date If you chose Manual for Date Range, enter the start date 
for the date range using the format mm/dd/yyyy. 

End Date If you chose Manual for Date Range, enter the end date 
for the date range using the format mm/dd/yyyy. 
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Student Multi-Section Report 

Field Description 

Name The name of the report 

Description A description of the report. 

Output Type Select the option indicating the format in which you want 
to receive the report: 

• PDF 

• Export (CSV) 

Sections Select the option indicating the sections for which you 
want to run the report: 

• Select Selected Class to generate a report for a 
class. 

• Select Active Classes to generate a report for all 
classes. 

Note: If running this report for multiple sections, courses 
are identified by course name and section number, instead 
of course name and expression. 

Student Schedule Select the option indicating the sections for which you 
want to run the report: 

• Select My Classes to generate a report for all my 
classes. 

• Select Total student schedule to generate a 
report for. 

Note: If running this report for multiple sections, courses 
are identified by course name and section number, instead 
of course name and expression. 

Students Select the option indicating the students for which you 
want to run the report: 

• Select Enrolled Students to generate a report for 
all students who are enrolled. 

• Select Selected Groups and/or Students and 
then select a set, group, individual student, 
selection of students, or any combination from the 
Students Group pane. 

Note: To generate a report for a set, group, individual 
student, selection of students, or any combination, use 
student groups. 

Abbreviate Select the Assignment checkbox to include assignment 
abbreviations instead of assignment names. 

Select the Categories checkbox to include category 
abbreviations instead of category names. 
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Field Description 

Include Select the Final Grades checkbox to include all final 
grades for a student in the report. 

Select the Assignment Scores checkbox to include all 
assignment scores for a student in the report. 

If Assignment Scores is selected, select the Score 
Comments checkbox to include all assignment score 
comments for a student in the report. 

Select the Category Summary checkbox to include a 
summary of assignment categories in the report. 

Note: If Total student schedule is selected, the Score 
Comments checkbox appears disabled. 

Reporting Term Choose ALL or the specific term for which you want to run 
this report from the pop-up menu. 

If you chose a specific reporting term, use the second pop-
up menu to indicate if you want to run the report for This 
term only or for This term and lower terms. 

Select the Include terms with no grades checkbox to 
include terms where scores have not yet been recorded in 
the report. 

Student Roster Report 

Field Description 

Name The name of the report 

Description A description of the report. 

Output Type Select the option indicating the format in which you want 
to receive the report: 

• PDF 

• Export (CSV) 

Sections Select the option indicating the sections for which you 
want to run the report: 

• Select Selected Class to generate a report for a 
class. 

• Select Active Classes to generate a report for all 
classes. 

Note: If running this report for multiple sections, courses 
are identified by course name and section number, instead 
of course name and expression. 

Students Select the option indicating the students for which you 
want to run the report: 
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Field Description 

• Select Enrolled Students to generate a report for 
all students who are enrolled. 

• Select Selected Groups and/or Students and 
then select a set, group, individual student, 
selection of students, or any combination from the 
Students Group pane. 

Note: To generate a report for a set, group, individual 
student, selection of students, or any combination, use 
student groups. 

Student Info Select the checkboxes indicating the student information 
you want included in the report: 

• Student Name 

• Student Number 

• Birthday 

• Gender 

• Grade Level 

Parent Info Select the checkboxes indicating the parent information 
you want included in the report: 

• Mother's Name 

• Father's Name 

• Home Phone 

• Guardian Email 

• Emergency Contacts 

• [Blank Field] 

If [Blank Field] is selected, enter the column heading in 
the text field. 

Note: If you enter column heading text and run the 
report, the text is available the next time you run the 
report. 

Sort Select the option indicating how you want to sort report 
output: 

• Student Last Name 

• Student First Name 

• Student Number 

• Birthday 

Report Preview As you make the above selections, this area displays how 
the report appears prior to actually running the report, 
giving you an opportunity to make adjustments. 
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Score Inspector Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Assignment Score 

Field Description 

Student Name of the selected student. 

Note the arrows next to the student name. Click the Next 
arrow to move to the next student (within the 
Scoresheet). Click the Previous arrow to move to the 
previous student (within the Scoresheet). 

Assignment Name of the selected assignment. 

Note the arrows next to the assignment name. Click the 
Next arrow to move to the next assignment (within the 
Scoresheet). Click the Previous arrow to move to the 
previous assignment (within the Scoresheet). 

Score Type How the assignment is recorded: Points, Percentage, or 
Letter Grade. 

Collected Whether an assignment for a student was collected. 

Late Whether an assignment for a student was turned in late. 

Exempt Whether an assignment for a student is exempt. 

Missing Whether an assignment for a student is missing. 

Score Score earned by the student for the selected assignment. 
Entry must match the score type: Points, Percentage, or 
Letter Grade. 

Points Points earned and points possible based on score entered. 

Percent Percentage based on score entered. 

Grade Letter grade based on score entered. 

Comment Detailed information about the assignment score. 

Click Comment Bank to select one or more predefined 
comments.  

Clear Click to discard any changes you made. 

Close Click to save your changes and close the window. 
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Final Grade 

Field Description 

Student Name of the selected student. 

Note the arrows next to the student name. Click the Next 
arrow to move to the next student (within the 
Scoresheet). Click the Previous arrow to move to the 
previous student (within the Scoresheet). 

Reporting Term Reporting term for the selected final grade. 

Manual Override Whether manual override of a final grade is enabled. 

Percent Percentage based on score entered. 

Grade Letter grade based on score entered. 

Points Points earned and points possible based on score entered. 

Comment Detailed information about the final grade. 

Click Comment Bank to select one or more predefined 
comments.  

Clear Click to discard any changes you made. 

Close Click to save your changes and close the window. 

Note: If the selected student's final grade includes a 
comment, the Clear Score window appears, displaying the 
message, "This score has a comment. Do you want to clear 
the Score Information?" Either click No or Yes. 

Scoresheet Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Final Grade Right-Click Menu 

Field Description 

Show Score Inspector Select the option to invoke the Score Inspector. 

Assignment Right-Click Menu 

Field Description 

Collected Select the option to indicate whether an assignment for a 
student was collected. 

Late Select the option to indicate whether an assignment for a 
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Field Description 

student was turned in late. 

Exempt Select the option to indicate whether an assignment for a 
student is exempt. 

Missing Select the option to indicate whether an assignment for a 
student is missing. 

Clear Scores Select the option to clear a score for the student. 

Fill Scores Select the option to invoke the Fill Scores utility. 

Show Score Inspector Select the option to invoke the Score Inspector. 

Scoresheet 

Field Description 

Filter By Reporting 
Term 

To view assignments and scores with a due date that falls 
within a specific reporting term, week, or month, choose a 
reporting term, week, or month from the pop-up menu. 
The Scoresheet window refreshes and displays only those 
assignments and scores with a due date that falls within 
that selected reporting term, week, or month. 

Filter By Category To view assignments that belong to a specific category, 
choose a category from the pop-up menu. The Scoresheet 
window refreshes and only displays assignments and 
scores for the selected category. 

Filter By Students To view assignments and scores for students with a 
different enrollments status, choose an enrollment status 
from the pop-up menu. The Scoresheet window refreshes 
and only displays assignments and scores for students 
with the selected enrollment status. For more information, 
see Filter Class Roster. 

Plus (+) Click to create a new assignment. The New Assignment 
window appears. See Assignment Details: Assignment 
Tab and Assignment Details: Publish Tab. 

Minus (-) Select an assignment and click to delete. The Delete 
Assignment window appears. 

Note: If an assignment does not have scores, the Delete 
Assignment window states, "Are you sure you want to 
delete assignment [name]?"  

If an assignment has scores, the Delete Assignment 
window states, "This assignment has scores. Are you sure 
you want to delete assignment [name] and all associated 
scores?"  

Click Yes. The assignment no longer appears on the 
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Field Description 

Assignment window. 

Students Student’s name, including last name and first name. Click 
the arrow next to the student's name to view student 
details. 

Final Grade Student’s final grade, including letter grade and 
percentage. If there are no scores, the final grade 
percentage appears as a double hyphen (--). 

Final Grade Comment 

If a final grade comment has been entered, a blue circular 
“C” appears. For more information, see Work with Final 
Grade Comments. 
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Field Description 

[Assignments] Assignments for this class. 

Assignment Column Heading 

Assignment column heading includes the assignment 
name, due date, and points possible. If you roll your 
mouse pointer over an assignment column heading, a pop-
up window displays the assignment name, category, due 
date, points possible, and weight. 

Click the arrow next to the assignment to view 
assignment details. 

Publish/Hide Assignment 

One of the following icons may appear in the assignment 
column heading based on the Publish Assignment pop-
up menu and Publish Scores checkbox settings:  

• If Immediately is selected, no icon appears, 
indicating the assignment and scores are published. 

• If On Specific Date, Days Before Due, and On 
Due Date are selected, a blue hourglass appears, 
indicating the assignment is waiting to be 
published. 

• If Never is selected, a blue circle with a slash 
through it appears, indicating the assignment and 
scores are not to be published. 

• If the Publish Scores checkbox is not selected, a 
red circle with an exclamation point appears, 
indicating scores are not to be published. 

For more information, see Publish Assignments. 

Assignment Field 

Assignment field can include the grade the student 
received for the assignment, as well as assignment status 
and comment. 

Assignment Status 

One of the following assignment statuses may appear in 
the assignment field based on how the assignment was 
marked: 

• If the assignment was marked as Collected and no 
score is entered, a green checkmark appears. 

• If the assignment was marked as Late, a red 
circular “L” appears. 

• If the assignment is marked as Exempt and no 
score is entered, an italicized “Ex” appears. 

• If the assignment is marked as Exempt and a 
score is entered, the score appears italicized and 
shaded. 
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Field Description 

• If the assignment is marked as Missing and no 
score is entered, an orange circular "M" appears. 

For more information, see Work with Assignment 
Status (Scoresheet) or Work with Assignment Status 
(Score Inspector). 

Assignment Score Comment 

If a score comment has been entered, a blue circular “C” 
appears. For more information, see Work with Score 
Comments. 

Summary The mean, median, and mode appears for each 
assignment and final grade. Click the down arrow to view 
summary information. Alternately, click the up arrow to 
hide the summary information. 

The mean is the mathematical average of the scores you 
entered. The median represents the middle of all values: 
one-half of the scores will be above this number and one-
half will be below it. The mode indicates the most common 
value. 

All of these values are indicators of how well students do 
on assignments. If any one of them is unexpectedly low, it 
may be that students need additional practice on the skills 
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Field Description 

and concepts being assessed, or the assessment needs to 
be revised. 

Points Earned, 
Percentage, Grade 

Select an assignment. The points earned, percentage, and 
grade to date appear in the lower-left corner of the 
Scoresheet. 

Revert Click to discard any changes you made. 

Note: This button appears shaded until information is 
entered. 

Save Click to save your changes. 

Note: This button appears shaded until information is 
entered. 

Select Comments Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Field Description 

Code The numeric, alphabetical, or alphanumeric 
comment code. 

Click the column heading to sort in descending 
order. Click the column heading again to sort in 
ascending order. 

Comment The comment text. 

Click the column heading to sort in ascending 
order. Click the column heading again to sort in 
descending order. 

Select one or more predefined comments. Press 
and hold COMMAND (Mac) or CONTROL 
(Windows) to select multiple comments. 

Category The category to which the comment is assigned. 
The comment bank groups the comments by 
category. 

Click the column heading to sort in ascending 
order. Click the column heading again to sort in 
descending order. 

Separate Use the pop-up menu to indicate the method by 
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Comments 
Using 

which you want to separate comments: 

• Choose Spaces to separate comments 
using double spaces. 

• Choose Line Breaks to separate 
comments using a new line. This is the 
initial default setting. 

Note: After you indicate a preference, it becomes 
the default setting. 

Insert 
Selected 
Comments 

Click to insert the selected predefined comments 
into the Comments field. 

[Comments] The selected predefined comments appear. 

Note: You can also manually enter comments in 
this field. 

Cancel Click to discard any changes you made. 

OK Click to save your changes. 

Student Groups Pane 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Field Description 

Entire Class Student group for entire class. Right-click to Add 
Set. 

[Set] Name of the first tier in the hierarchical structure 
of student grouping. 

Double-click the set name to rename and press 
ENTER or RETURN. 

Right-click and select Add Set to add another set. 

Right-click and select Add Group to add another 
group to the selected set. 

[Group] Name of group within a set. 

Double-click the set name to rename and press 
ENTER or RETURN. 

Right-click and select Add Set to add another set. 

Right-click and select Add Group to add another 
group to the selected set. 

[Students] Students within a selected group. 
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Students Window 
The following tables describe the fields that are visible on this window when performing 
certain functions. 

Students 

Field Description 

Filter By 
Students 

To view students with a different enrollment 
status, do one of the following: 

• Choose ALL from the Students Filter By 
pop-up menu. The Students window 
refreshes and displays students who are 
both currently enrolled and those who are 
no longer enrolled in the class. 

• Choose Active from the Students Filter 
By pop-up menu. The Students window 
refreshes and displays only those students 
who are currently enrolled in the class. 

• Choose Dropped from the Students 
Filter By pop-up menu. The Students 
window refreshes and displays only those 
students who are no longer enrolled in the 
class. 

Students Student’s name, including last name and first 
name. Double-click the student's name or click 
the arrow next to the student's name to view 
student details. 

The current count of students appears in the 
column heading. The count updates automatically 
as students are added or dropped from the 
section. 

Note: Click the column heading to sort the 
Students window by students' last names. When 
sorted in ascending order, an upward pointing 
arrow appears in the column heading. When 
sorted in descending order, a downward pointing 
arrow appears in the column heading. 

Student 
Number 

Student’s identification number. 

Note: Click the column heading to sort the 
Students window by students' numbers. When 
sorted in ascending order, an upward pointing 
arrow appears in the column heading. When 
sorted in descending order, a downward pointing 
arrow appears in the column heading. 

Birthday Student's date of birth. 

Note: Click the column heading to sort the 
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Students window by students' birthdays. When 
sorted in ascending order, an upward pointing 
arrow appears in the column heading. When 
sorted in descending order, a downward pointing 
arrow appears in the column heading. 

Gender Student’s gender. 

Note: Click the column heading to sort the 
Students window by students' gender. When 
sorted in ascending order, an upward pointing 
arrow appears in the column heading. When 
sorted in descending order, a downward pointing 
arrow appears in the column heading. 

Grade Level Student’s grade level. 

Note: Click the column heading to sort the 
Students window by students' grade levels. When 
sorted in ascending order, an upward pointing 
arrow appears in the column heading. When 
sorted in descending order, a downward pointing 
arrow appears in the column heading. 

Home Phone Student’s home phone number. 

Note: Click the column heading to sort the 
Students window by students' home phone 
numbers. When sorted in ascending order, an 
upward pointing arrow appears in the column 
heading. When sorted in descending order, a 
downward pointing arrow appears in the column 
heading. 

Student Details 

Field Description 

[Photo] Student's school picture. 

[Alert] Discipline, Guardian, Medical or Other icons 
appear if an alert exists for student. Click an icon 
to view the alert text.  

Name Student’s first and last name. 

Gender Student’s gender. 

Birthday Student's date of birth. 

Father's 
Name 

Student's father's name. 

Mother's 
Name 

Student's mother's name. 

Emergency Student’s emergency contact information. Click to 
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Contacts view the telephone number in large print. 

Student 
Number 

Student’s identification number. 

Grade Level Student’s grade level. 

Home Phone  Student’s home phone number. Click to view the 
telephone number in large print. 

Guardian E-
mail 

Student's guardian's e-mail address. Click to copy 
the e-mail address to your clipboard. 
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